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C O P Y R I G H T  I N F O R M A T I O N

Copyright © 2013 Visioneer, Inc.

Part Number: 05-0882-000

Changes are periodically made to this document. Changes, technical inaccuracies, and typographic errors will be corrected in subsequent 
editions.

Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

The Visioneer® brand name and logo, OneTouch™ brand name and logo, and Visioneer Acuity, are trademarks or registered trademarks of 
Visioneer, Inc. The PaperPort®, OmniPage® Pro, and PDF Converter brand name and logo are registered trademarks of Nuance 
Communications, Inc. Adobe®, Adobe® Acrobat®, Adobe® Reader®, and the Adobe® PDF logo are registered trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. The Adobe PDF® logo will appear in this product’s software, and full access to Adobe 
software features is only available if Adobe® Reader® or Adobe® Acrobat® is installed on your computer.

This product is covered by one or more of the following patents: 6, 480, 304; 5,818,976; 5,499,108; 5,517,332.

Microsoft is a U.S. registered trademark of Microsoft Corporation. Windows is a trademark and SharePoint® is a registered trademark of 
Microsoft Corporation. Mac and Mac OS are trademarks of Apple Inc., registered in the U.S. and other countries. ZyINDEX is a registered 
trademark of ZyLAB International, Inc. ZyINDEX toolkit portions, Copyright © 1990-1998, ZyLAB International, Inc. All Rights Reserved. All other 
products mentioned herein may be trademarks of their respective companies.

Information is subject to change without notice and does not represent a commitment on the part of Visioneer. The software described is 
furnished under a licensing agreement. The software may be used or copied only in accordance with the terms of such an agreement. It is 
against the law to copy the software on any medium except as specifically allowed in the licensing agreement. No part of this document may 
be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or information 
storage and retrieval systems, or translated to another language, for any purpose other than the licensee's personal use and as specifically 
allowed in the licensing agreement, without the express written permission of Visioneer. 

Restricted Rights Legend
Use, duplication, or disclosure is subject to restrictions as set forth in contract subdivision (c)(1)(ii) of the Rights in Technical Data and 
Computer Software Clause 52.227-FAR14. Material scanned by this product may be protected by governmental laws and other regulations, 
such as copyright laws. The customer is solely responsible for complying with all such laws and regulations. 

Visioneer's Limited Product Warranty
IF YOU FIND PHYSICAL DEFECTS IN THE MATERIALS OR THE WORKMANSHIP USED IN MAKING THE PRODUCT DESCRIBED IN THIS DOCUMENT, 
VISIONEER WILL REPAIR, OR AT ITS OPTION, REPLACE THE PRODUCT AT NO CHARGE TO YOU, PROVIDED YOU RETURN IT (POSTAGE PREPAID, 
WITH PROOF OF YOUR PURCHASE FROM THE ORIGINAL RESELLER) DURING THE 90-DAY PERIOD AFTER THE DATE OF YOUR ORIGINAL 
PURCHASE OF THE PRODUCT. UPON RECEIPT DURING THE INITIAL 90-PERIOD BY VISIONEER OF A VALID REGISTRATION OF THE PRODUCT, THIS 
LIMITED PRODUCT WARRANTY PERIOD IS EXTENDED TO THE 
12-MONTH PERIOD AFTER THE DATE OF YOUR ORIGINAL PURCHASE. IF A VALID REGISTRATION IS NOT RECEIVED DURING THE INITIAL 90-DAY 
PERIOD, THE 12-MONTH WARRANTY IS NO LONGER AVAILABLE AND YOUR PRODUCT WARRANTY WILL TERMINATE AFTER THE 90-DAY INITIAL 
PERIOD EXPIRES.

THIS IS VISIONEER'S ONLY WARRANTY AND YOUR EXCLUSIVE REMEDY CONCERNING THE PRODUCT, ALL OTHER REPRESENTATIONS, 
WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, WRITTEN OR ORAL, INCLUDING ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A 



PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE EXPRESSLY EXCLUDED. AS A RESULT, EXCEPT AS SET OUT ABOVE, THE PRODUCT IS SOLD 
“AS IS” AND YOU ARE ASSUMING THE ENTIRE RISK AS TO THE PRODUCT'S SUITABILITY TO YOUR NEEDS, ITS QUALITY AND ITS PERFORMANCE. 

IN NO EVENT WILL VISIONEER BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY 
DEFECT IN THE PRODUCT OR FROM ITS USE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

All exclusions and limitations in this warranty are made only to the extent permitted by applicable law and shall be of no effect to the extent in 
conflict with the express requirements of applicable law. 

RoHS and WEEE Compliance
This product is compliant with RoHS Regulations of the European Parliament and Council Directive on the Restrictions of the Use of Certain 
Hazardous Substances in Electrical and Electronic Equipment (2002/95/EC), and with the Waste Electrical and Electronic Equipment (WEEE) 
Directive (2002/96/EC). 

FCC Radio Frequency Interference Statement
This equipment has been tested and found to comply with the limits for the class B digital device, pursuant to part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and if not installed, and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged 
to try and correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help.

This equipment has been certified to comply with the limits for a class B computing device, pursuant to FCC Rules. In order to maintain 
compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the 
equipment without the approval of manufacturer could void the user's authority to operate this equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

ENERGY STAR for the USA
Energy Program compliance

As an ENERGY STAR® partner, Visioneer Inc. has determined that this product meets the ENERGY STAR guidelines for energy 
efficiency. 

The ENERGY STAR and ENERGY STAR MARK are registered United States trademarks. The ENERGY STAR Imaging Equipment Program is a 
team effort between the U.S., European Union and Japanese governments and the office equipment industry to promote 
energy-efficient copiers, printers, fax, multifunction machine, personal computers, and monitors. Reducing product energy 
consumption helps combat smog, acid rain and long-term changes to the climate by decreasing the emissions that result from generating 
electricity.

Visual Display
Warning: This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual 
display workplaces, this device must not be placed in the direct field of view.
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W E L C O M E

This chapter includes:

• What’s in the Box on page 10

• System Requirements on page 11

• Documentation on page 12

• The Visioneer RoadWarrior 3 on page 13

• Unpack the Scanner on page 14

Congratulations on purchasing your Visioneer RoadWarrior 3. With this scanner you can quickly scan paper items 
such as letters or receipts and place their electronic images on your computer. Powered through the USB port on 
your computer, this scanner is perfect for taking on the road. 
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WHAT’S IN THE BOX

Before proceeding, check the contents of the box. If items are missing or damaged, contact the dealer where you 
purchased the scanner.

Visioneer RoadWarrior 3 Carrying Bag

Installation Disc Calibration Page Cleaning Cloth USB Cable

Quick Install Guide Technical Support 
Card
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SYSTEM REQUIREMENTS

Pentium 4 PC or AMD equivalent with:

• A DVD-ROM drive

• An available Universal Serial Bus (USB) port

• Microsoft® Windows® operating system: 

• 32-bit Windows XP (Service Pack 1 and 2)
• 32-bit or 64-bit Windows Vista (Service Pack 1)
• 32-bit or 64-bit Windows 7
• 32-bit or 64-bit Windows 8
The scanner is compatible with Service Pack 3 for Windows XP, Service Pack 2 for Windows Vista, and Service 
Pack 1 for Windows 7.

• Minimum of 2 gigabyte (GB) of internal memory (RAM)

• 350 MB minimum of free hard disk space

A VGA or SVGA Monitor:

• The recommended settings for your monitor are:

• Color quality of 16-bit or 32-bit
• Resolution set to at least 800 x 600 pixels

Refer to your Windows documentation for instructions on setting the color quality and resolution for the monitor.
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DOCUMENTATION

The following printed documentation is provided in the box:

• Installation guide—abbreviated scanner setup and installation instructions.

• Technical support card—contact information for technical support and customer service, and a brief 
overview of our standard product warranty.

The following soft-copy documentation is available on the installation disc:

• Scanner user’s guide—contains detailed installation, configuration, scanning, and maintenance 
instructions.

• Nuance PaperPort user’s guide—contains detailed information using the application and managing your 
scanned documents.

• Nuance OmniPage user’s guide—contains detailed instructions on using the software, including 
information on using Optical Character Recognition to create editable text files from the scanned 
documents.

• Nuance PDF Converter user’s guide—contains detailed information on using the application to create and 
modify PDF files. 



WELCOME 13
THE VISIONEER ROADWARRIOR 3

Paper feed—place an item face up in paper feed aligned to the left side. 

• Paper sensor—the optical sensor on the left side of the paper feed slot. Detects when an item has been 
inserted in the scanner.

• Scanner top—can be pulled away from the scanner body to open the scanner for cleaning.

Paper return—guides paper up from the back of the scanner as it is exited during scanning.

Paper guide—helps to prevent documents from skewing while feeding through the scanner during scanning. 
Slide the guide left or right to adjust the guide to the width of the document you want to scan.

• Alignment strip—alignment marks for common paper sizes for the paper guide.

Scanner button—button control for the scanner. When a scan is in progress, pressing the button will cancel the 
scan. When no paper is in the scanner, long-press will open the OneTouch properties window. When 
AutoLaunch™ is turned off, pressing the button will start scanning.

Universal Serial Bus (USB) port—connects the scanner to the computer.

Paper ReturnPaper Feed Scanner button USB port

3 41 2 5

5

4

3

2

1

Paper Guide
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UNPACK THE SCANNER

Remove the clear plastic film from the top of the scanner.

Remove any shipping tape from the scanner body.



I N S T A L L A T I O N

This chapter includes:

• Before You Begin on page 16

• Install the Software and Connect the Scanner on page 17

• Register Your Scanner on page 23

• Installing Additional Applications on page 24

• View the User Guides on page 25
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BEFORE YOU BEGIN

Please make sure of the following before you begin installation:

• If you are prompted to reboot during installation, please select “No”. Finish installing the rest of the software, 
then close all open windows and reboot your computer. 

• The information in this guide may cover software not provided with the scanner you purchased. Please 
disregard any information about the software not applicable to your scanner. Visit our web site at 
www.visioneer.com for the latest software updates for your Visioneer scanner.

• If your computer has AntiVirus or AntiSpyware software running, you may encounter alerts or messages 
during installation asking you to allow the installation to proceed. Although the messages will differ based 
on the software your computer is running, in each case you should allow the installation to proceed if that 
option is available. Alternatively, you can turn off the AntiVirus or AntiSpyware software before installing 
your scanner, but if you do, make sure to turn it back on again when installation is finished.

• If you already have a scanner connected to your computer, it is recommended that you remove that 
scanner’s driver program prior to installing your Visioneer scanner. You can remove these programs from the 
Windows Control Panel. Please refer to the user manual provided with your other scanner hardware for 
instructions about removing the driver and software for that unit.

• If your computer is running Windows Vista or later, you may see the Windows User Account Control screen 
asking you to confirm system changes. Click the Yes button to allow the installation to proceed.
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INSTALL THE SOFTWARE AND CONNECT THE SCANNER

1. Start Microsoft Windows and make sure that no other applications are running.

2. Insert the installation disc into your computer’s DVD-ROM drive.

The disc automatically starts.

3. The disc’s Main menu window opens.

4. On the Main menu, select Install software.

NOTE: If the disc does not start, check the following:

• Make sure the disc drive’s door is completely shut.
• Make sure the disc was inserted in the drive in the proper direction (label side up).
To launch the disc manually:
• Open the Windows options for your computer’s disc drives.
• Double-click the icon for your DVD-ROM drive. 
• The Installation menu for the disc should now open.
If the menu does not open:
• From the list of files on the disc, double-click the file named setup.exe.
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5. Make sure the boxes for Scanner Driver and Visioneer OneTouch are selected, as well as any other 
applications you want to install.

6. Click Install now.

The scanner driver installation will start first.

INSTALLING THE SCANNER DRIVER

1. The Welcome to the Visioneer Setup Wizard opens.

2. Click Next.

3. On the Visioneer License Agreement window, read the license agreement. If you accept the terms, select I 
Agree then click Next. 

NOTE: The software provided with your scanner may differ slightly from the list shown in the window.
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• If you choose not to accept the license agreement, click Cancel. Click Close on the Installation 
Interrupted window.

4. The software will now be installed.

5. Stop when you see the “Complete the installation by connecting your hardware” window. Do not click OK 
yet. Leave the window open and proceed to the next section.

NOTE: If you do not see this on-screen diagram for connecting the scanner, stop and follow the instructions below.

CONNECT THE USB CABLE

The scanner does not have an external power supply. It draws its power directly from the computer through the 
USB cable. If you use a USB hub with your computer, the hub must have its own power supply. The scanner does 
not have an on/off switch. The scanner is ready to scan as soon as its software is finished loading onto your 
computer.

1. Remove any tape from the USB cable.

2. Plug the USB cable into the USB port on the scanner then into a USB port on the computer. 
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NOTE: If the plug does not attach easily, make sure that you are plugging it in correctly. Do not force the plug 
into either connection.

3. Your computer recognizes that a device has been plugged into the USB port and automatically loads the 
appropriate software to run the scanner. A progress window opens on-screen. Do not close this window as it 
displays the connection status as Windows loads the driver for your scanner. 

A status bubble may appear in the Windows notification area.

4. When the driver finishes loading, the status window will automatically close. If it does not, click Close on this 
window when the text indicates that the device is ready to use.

A status bubble may appear in the Windows notification area.

NOTE: the scanner should have been calibrated at the factory. If the driver does not read that the scanner is 
calibrated, a calibration utility will open. Follow the instructions on-screen to calibrate the scanner.
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5. When you’re certain that the software has completely loaded, return to the “Complete the installation by 
connecting your hardware” window. 

6. Click OK to complete the installation process.

7. Click Close on the Installation Complete window to close and exit the driver installer.

INSTALLING VISIONEER ONETOUCH

The Visioneer OneTouch software installation will start automatically after you click Close on the driver 
Installation Complete window. OneTouch is the software needed for the buttons on the scanner to work.
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1. Click Next on the Welcome to the OneTouch Setup Wizard.

2. On the Visioneer License Agreement window, read the license agreement. If you accept the terms, select I 
Agree then click Next.

If you choose not to accept the license agreement, the installation will terminate and OneTouch will not be 
installed.

3. Click Close on the Installation Complete window to close and exit the software installer.

If you selected other software to install from the DVD the installation for that software will automatically start 
after you click Close on the Installation Complete window. Follow the instructions on-screen to install each 
application you selected.
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REGISTER YOUR SCANNER

Registering your scanner is important as it provides you with access to our free telephone support service. 
Registration also gives you free access to software updates for your scanner.

You will need an active Internet connection to register your scanner. If you do not have internet access, you can 
contact our Customer Service department to register the scanner. Please refer to the Technical Support Card, that 
your received with the scanner, for our contact information.

1. Open an Internet Explorer window, or other internet browser that you have installed on your computer.

2. In the web address field type: www.visioneer.com

3. Press Enter on your computer’s keyboard or click the option on screen to go to the web address.

4. When the Visioneer scanners web page loads click on Register Your Product.

5. Fill in the registration form, all required fields have an asterisk (*).

NOTE: A valid e-mail address is required for registration.

6. You will be asked to enter the serial number for the scanner, it is located on either the back or underneath 
the scanner.

7. After filling in the form, click on Submit Your Registration to complete the registration.
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INSTALLING ADDITIONAL APPLICATIONS

Your scanner includes free, additional applications as described in the table below.

1. Return to the disc’s Main menu and click Install products.

2. Select the additional applications you want to install, then click Install now. 

3. Follow the instructions on the screen to install each of the additional applications.

Software About the Software

Nuance PaperPort® PaperPort is a document management software application. The PaperPort 
scanning features allow you to insert new pages into an existing file and name your 
file immediately after scanning. From within the PaperPort desktop you can sort 
your documents and move them between folders as you would through the 
Windows My Documents folder. You can reorder the pages in a PDF file, and 
unstack a document so all the pages are resaved as individual files. PaperPort also 
has some basic image editing options in the PaperPort PageView, such as; adding 
notes to image files, modifying image colors, and touch up the image using the 
erase and/or auto-correct options.

Nuance OmniPage® OmniPage Pro provides precision OCR analysis, advanced layout detection, and 
Logical Form Recognition™ (LFR) technology. Advanced security features quickly 
turn office documents and forms into over 30 different PC applications for editing, 
searching and sharing. Custom workflows handle large volumes of documents, and 
you can use its tools to print to PDF.

Nuance PDF Converter PDF Converter Professional 7 features 100% industry-standard PDF creation and 
editing plus the world’s most accurate PDF conversion to editable Microsoft® 
Office® formats available. It also offers one-click scanning to PDF, the most 
advanced PDF search capabilities, excellent graphics management, document 
flattening and auto-removal of sensitive information. Combining unparalleled 
functionality, built-in intelligence and ease of use, PDF Converter Professional 7 
enables users to create, convert, edit, assemble and securely share PDF files like 
never before for enhanced professionalism, productivity and collaboration.
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VIEW THE USER GUIDES

1. Return to the disc’s Main menu and click on User guides.

2. Click on View scanner documentation to access the scanner user guide.

Click on View software documentation to access the user guides for the software applications provided 
with the scanner.

3. When you’re finished, click Main menu to return to the Main menu window and click Exit.

4. Remove the installation disc and store it in a safe place.

That’s it! Installation is finished and your Visioneer scanner is ready to scan.
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S C A N  U S I N G  A U T O L A U N C H

This chapter includes:

• Scanning on page 29

• Configuring OneTouch AutoLaunch on page 30

• Turn AutoLaunch Off/On on page 31

• Scanning Interfaces on page 33

When you insert an item into the scanner, it is automatically scanned and the image is sent to a destination 
location or application on your computer, or to a network drive.

NOTE: Always remove any staples or paper clips from documents before inserting them into the scanner’s paper 
feed. Staples and paper clips can jam the feed mechanism and scratch the internal components. Also remove 
any labels, stickers, or Post-It™ notes that may come off during the scanning process and get stuck in the 
scanner. Misuse as described here will void your scanner’s warranty. 
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CHOOSING THE PAPER RETURN POSITION

Push lightly on the Paper Return to open and rotate the Paper Return into position.

When the Paper Return is closed, any item scanned will exit out of the back of the scanner. When the Paper Return 
is open, it guides the paper up from the back for easy access to remove it from the scanner.

NOTE: the Paper Return should be closed when scanning plastic cards, business cards, and any other type of thick 
paper. These items will hit the paper return and stay in the paper feed path. We do not recommend you use the 
Paper Return if you are scanning photos, or any other type of document where the ink or gloss may flake off due 
to the page being angled out of the scanner.

Example: Paper Return closed Example: Paper Return open
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SCANNING

1. Adjust the paper guide to the width of the document you want to scan.

2. Insert a document into the scanner, face up and aligned to the left side of the paper feed slot.

The scanner grabs the top edge of the paper and automatically begins to scan and feed the paper through 
the scanner.

3. A scan progress window opens and the image is sent to the selected application for PaperIn button. 

In this example the Destination Application is the PaperPort desktop.

4. You can now work with the image in the Destination Application.
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CONFIGURING ONETOUCH AUTOLAUNCH

When you installed the scanner, the software configured OneTouch with all applications on your computer that 
you can scan to. The button consists of: a Destination Application, a Scan Configuration, and a File Format.

You can open the OneTouch Properties window by pressing the button on the scanner, or by opening it from the 
OneTouch Panel on screen. 

1. Click on the OneTouch icon. 

2. Right click on the PaperIn button, single left click on the detailed information.

3. The OneTouch Properties window opens.

Changing the PaperIn setting:

1. Click on an application name in the Select Destination list.

2. Select a file format in the Select Format panel.

3. Select a scanning configuration in the Select Configuration list.

4. Click on OK to save the changes.

5. Place a page in the scanner.

6. The scanner starts scanning and sends the image to the application, with the file format and scanning 
configuration you specified.

NOTE: The next section contains detailed information on making changes to the OneTouch Properties window. 
Please see Changing the Button Settings on page 40 for instructions.

NOTE: Some of the options on the OneTouch Properties Window are “grayed out” and are not available, these 
options are not appropriate for your scanner model.

Right click on PaperIn, left lick on 
the detailed information, or press 
the button on the scanner to open 
the OneTouch Properties.
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TURN AUTOLAUNCH OFF/ON

If you want to scan from OneTouch button panel on screen, or to be able to place a page in the scanner and wait 
until you are ready to initiate the scan, you can turn the AutoLaunch feature off. This option is in the Application 
Settings for your scanner’s hardware properties. 

To turn AutoLaunch off or on:

1. Click on the OneTouch icon in the Windows notification area on the right side of the screen.

2. Click on the scanner icon to the right of the green buttons, in the title bar of the OneTouch button panel.

3. Click on the Properties button in the hardware properties window.

OneTouch Icon

Hardware icon
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4. In the Application Settings tab, click on Turn on AutoLaunch™ to deselect this option.

5. Click on OK to save the changes and close the window. Click on OK to close the Hardware Properties 
window.

The AutoLaunch feature is now turned off. Your scanner will not start scanning until you click on the scan button 
on the OneTouch button panel, or on the scanning interface from the application you are using. 

To turn AutoLaunch back on, follow the instructions in this section and click on the option in step 4 to select to 
enable the feature.
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SCANNING INTERFACES

If you selected the recommended installation options, then you have several different options to scan with your 
Visioneer RoadWarrior 3 scanner. 

• OneTouch AutoLaunch—To use the scanner’s AutoLaunch feature, simply insert a document in the scanner 
and it is automatically scanned using predefined settings from the OneTouch software. Please see Scanning 
on page 29. 

• OneTouch Button Panel—Use this scan option when you want to scan from the computer screen. This 
scans with the same settings as when using the AutoLaunch scanning feature. Please see Changing the 
Button Settings on page 40.

• TWAIN Interface—This option uses your scanner’s TWAIN interface to scan. Select scanning options before 
scanning, put the document in the scanner, then click the Scan button in the TWAIN interface window. 
Please see Scanning from TWAIN and WIA on page 123.



VISIONEER ROADWARRIOR 3 SCANNER USER’S GUIDE34



S C A N N I N G  A N D  C O N F I G U R I N G  
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This chapter includes:

• Scanning and Configuring OneTouch on page 35

• Default OneTouch Settings on page 37

• Changing the Button Settings on page 40

• Selecting Options for OneTouch on page 42

• Scan Configurations on page 45

• File Formats on page 53

• Create Single Image Files on page 53

• Image Formats on page 53

• Text Formats on page 56

• Configure Before Scan on page 58

• Open Scanned Document(s) on page 60

• Transfer to Storage on page 61

• Scanning to Multiple Folders on page 63

• Burn to CD-ROM on page 67

• Printer or Fax on page 69

• PaperPort on page 71

• SharePoint on page 74

• FTP Transfer on page 77

• SMTP on page 80

• Email Applications on page 83

• Text Editors on page 85

• Still Image Client on page 89

• Image Editors on page 91

• PDF Applications on page 94

• Send to Application on page 97

• Scanning to Multiple Destinations on page 100

• Scanning with Job Separation on page 103
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• Scanning with Optical Character Recognition (OCR) on page 106

• OneTouch with Visioneer Acuity Technology on page 118

• Hardware Properties on page 121

Based on the recommended full installation of the scanner driver and the Visioneer OneTouch software, 
OneTouch is your main scanning interface for using the scanner. 

The OneTouch Button Panel, that you see on the computer screen, shows the pre-set function for each button 
(such as Email) and the icon of the destination (called the Destination Application) where the images will be 
sent when scanning is finished.

The OneTouch button panel shows which 
application the button is configured to send 
images to.
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DEFAULT ONETOUCH SETTINGS

When you installed the scanner, the software configured each OneTouch button with appropriate settings 
consisting of: a Destination Application, a Scan Configuration, and a File Format. The button names, such as Email 
or Copy, indicate the original factory settings for a button. You can change any of these settings. Please see 
Changing the Button Settings on page 40 for instructions.

For example, the Email button is set up to scan documents then immediately attach them to a new email 
message in your default email program. The email application will default to the email program specified in the 
internet options of Internet Explorer.

A folder icon for a button means that the button is set up to archive the scanned item. The scanner sends the 
scanned image directly to a folder without opening the image first in a software application.

A question mark for a button means your computer does not have the appropriate software or hardware for the 
initial factory settings. 

If the OneTouch OmniPage Module is not installed, then the options for sending to word processing applications 
such as Microsoft Word will not be available. The OneTouch OmniPage module is installed automatically when 
you install Visioneer OneTouch from the installation disc.

NOTE: The default page size in each configuration is based on your computer’s Windows Measurement system 
selection of U.S. (United States) or Metric units.

• If U.S. is the selected measurement, the default page size in each profile will be based on the United States 
standard paper sizes such as 8.5 x 11 inches.

• If Metric is the selected measurement, the default page size in each profile is based on the ISO 216 standard 
and the majority of the profiles will default to A4.
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SCAN FROM THE ONE TOUCH BUTTON PANEL

Scanning from the button panel on your computer’s screen works like inserting a page in the scanner when 
AutoLaunch is turned on.

To scan from the One Touch Button panel:

Follow the steps in the previous section to turn off the AutoLaunch feature before scanning with the One Touch 
panel. If AutoLaunch is turned on, the scanner will automatically scan when a page is inserted in the scanner.

1. Place a page face up in the paper feed slot, aligned to the arrow on the right side of the scanner.

2. Click on the One Touch icon in the Windows notification area (at the lower right corner of the screen.)

3. The One Touch panel opens. 

4. Click on the PaperIn button.

5. A scan progress window opens and the image is sent to the selected application for the One Touch button. 

In this example the Destination Application is the PaperPort desktop.

6. You can now work with the image in the destination application.

FEATURES OF THE ONE TOUCH BUTTON PANEL

The One Touch panel is your on-screen set of controls for the scanner. From the panel you can access the 
hardware settings for your scanner and configure the PaperIn button.

One Touch Icon
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Click on the One Touch icon to open the panel.

The Title Bar

• Green arrows—click to cycle through the panel’s 2 views.

• Scanner icon—click to open the scanner’s hardware properties.

• Red “X”—click to close the One Touch panel.

The Button View

• Left-click on a Destination Application icon to start scanning.

• Right-click on a Destination Application icon to open the One Touch Properties.

• Single-click on the detailed information to open the One Touch Properties.

The Hardware View

• Left-click on the scanner icon to return to the Button view.

• Right-click on the scanner icon to open the scanner’s hardware properties.

The Hardware View The Button View
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CHANGING THE BUTTON SETTINGS

1. Click on the OneTouch icon. 

2. Right-click a button on the OneTouch Button Panel.

3. The OneTouch Properties window opens.

Some of the options on the OneTouch Properties Window are “grayed out” and are not available, these 
options are not appropriate for your scanner model.

4. Select the destination you want OneTouch to send the scanned image to in the Select destination list. 

If you select a word processing program such as Microsoft WordPad or Microsoft Word that can be used for 
OCR (such as TXT or RTF), the text in scanned images is automatically converted to word processing text. 

5. Select a file format in the Select format panel.

The formats are based on the type of Destination Application you select. The icon names indicate their file 
types. See File Formats on page 53 for more information about the available formats.

6. Select a scanning configuration in the Select configuration list.

The configuration’s basic settings include: scanning mode, resolution (dpi), page size, brightness (Br), and 
contrast (Cr). To see a selected scan configuration’s settings, click its icon. Click the icon again to close the 
detailed information. Refer to Scan Configurations on page 45 and Configure Before Scan on page 58 for 
instructions on creating and modifying scan configurations.

7. Click on OK to save the changes.

8. Place an item in the scanner and click the OneTouch button to start scanning.

Select the 
Destination 
Application that 
will open when 
you are finished 
scanning. You use 
the destination 
application to 
view and work 
with your 
scanned images.

Select a 
configuration 
for scanning 
the item. 

Select a file 
format for your 
scanned 
images.

Scanner button 
configuration tab
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The scanner scans and sends the image to the selected destination, with the file format and scan configuration 
you specified.

Properties button—displays a window for selecting properties for a destination. This button is disabled if the 
selected destination application does not have global configuration properties.

Refresh button—updates the links between all your computer’s Destination Applications and OneTouch. If you 
install new software that can be used as a Destination Application, click the Refresh button to link the new 
software to OneTouch.

New/Copy/Edit/Delete buttons—click New or Copy to add new scan configurations to the list. Click Edit or 
Delete to change or remove them. 

OK/Cancel/Apply buttons—OK accepts any changes and closes the window. Apply accepts any changes but 
leaves the window open so you can continue making additional changes. Cancel closes the window without 
accepting any changes.
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SELECTING OPTIONS FOR ONETOUCH

Use the Options tab to configure how OneTouch works with the selected button, such as which destinations are 
available, or what the file name should be. 

Show all destinations—this option selects all of the Destination Application categories. The list of Destination 
Applications available for the selected button will include all the applications on your computer that fall into 
these categories. 

Select destinations—select this option to individually choose the types of applications to include in the list of 
Destination Applications. Check the boxes for the type of application to include. 

Destination Categories:

• Document management includes Nuance PaperPort and other applications for processing and keeping 
track of your scanned documents. This category includes the Send to Application and Open Scanned 
Document(s) destinations.

• Image editors include Microsoft Paint and other drawing and graphics applications.

• Text editors include Microsoft Word and WordPad, Microsoft Excel, and other word processing and 
spreadsheet applications. Select this option if you want OCR processing to convert your scanned documents 
to text that you can edit.

• PDF applications are for viewing and/or editing Adobe PDF files.

• Email includes Microsoft Outlook and other email applications, as well as the SMTP destination which allows 
you to scan directly to the SMTP server without opening an email client application.

• Storage and CD-R/W is for scanning directly to a folder on the computer, server, FTP server, SharePoint site, 
or to the Windows CD temp directory for burning the files to a CD.

• Fax and Print is for sending your scanned documents directly to your printer or fax software. 

• STI event forwarding is for using another application’s interface for scanning. The OneTouch Event 
Forwarding dialog box opens so you can select which application to use to continue scanning.
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Enable scanning to multiple destinations—select this option to allow for multiple destinations to be selected, 
in the destination list, on the OneTouch configuration tab. This feature allows you to scan one time while 
distributing the file to multiple destinations. Please refer to Scanning to Multiple Destinations on page 100.

Instant delivery—enables image transfer to the destination while scanning is in progress, provided that Create 
Single Image Files is also selected. If Create single image files is not selected, image transfer occurs after all 
pages have been scanned.

Show progress window—select this option to display the progress window of the document(s) during scanning.

Use job separator when scanning multiple pages—select this option to have the scanner separate multiple 
page scan jobs into separate files when scanning is complete. 

• When a blank page is detected—select this option to have a new file created each time a blank page is 
detected in the stack of pages being scanned. Note that when scanning duplex, both sides of the page must 
be blank.

• When the number of images reaches—select this option, and input a number in the box, to have a new 
file created each time the number of images scanned reaches the number you input in this field. Note that 
when scanning duplex, the number of images detected is twice the number of pages scanned. For example, 
if you input “5” in the field, and scan 10 pages, 20 images are captured, and you will get 4 separate files with 
5 images in each file.

Please refer to Scanning with Job Separation on page 103 for detailed information about scanning with job 
separation, and how it works with other options in OneTouch.

Use custom file naming—select this option to enable the input field so that you can specify the file name for 
your scanned document(s). You can specify a different file name for each OneTouch button. When this option is 
not select, the file name is automatically generated by OneTouch for all scans.

• The preview area, to the right of the Use custom file naming text, shows an example of the filename as you 
type into the input field and/or select token options from the list.

• Type the file name you want into the input field. Note that you cannot input these characters in a file name: \ 
/ : * ? “ < > |

When inputting a file name, the file name must be unique, otherwise every scan created would overwrite 
the previous scan. The menu to the right of the input field contains a list of tokens you can select to create 
unique file names. These tokens include counting numbers, date and time values, number of pages scanned, 
and so on. If the button name is not unique, you will see an on-screen notification that a {BatchID} and {#b} 
will be inserted into the name. 

• Click the down arrow and selected a token value from the list, then click the arrow button to add that value 
to the file name field. The token values are:

• {FN}—inserts the scanner name.
• {#b}—inserts the image number without adding zero (1).
• {#03b}—inserts a 3-digit image number in the scan batch (001).
• {D}—inserts the numeric day of the month without a zero added to single-digit days (4).
• {DD}—inserts the numeric day of the month with a zero added to single-digit days (04).
• {DDD}—inserts the abbreviated 3-letter day (Mon).
• {DDDD}—inserts the full name of the day (Monday).
• {M}—inserts the numeric month without a zero added to single-digit months (8).
• {MM}—inserts the numeric month with a zero added to single-digit months (08).
• {MMM}—inserts the abbreviated 3-letter month (Aug).
• {MMMM}—inserts the full name of the month (August).
• {YY}—inserts the two-digit year (97).
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• {YYYY}—inserts the four-digit year (1997).
• {h}—inserts the 12-hour clock hour without a zero added to single-digit time values (2).
• {hh}—inserts the 12-hour clock hour with a zero added to single-digit time values (02).
• {H}—inserts the 24-hour clock hour without a zero added to single-digit time values (2).
• {HH}—inserts the 24-hour clock hour with a zero added to single-digit time values (02).
• {m}—inserts the minute without a zero added to single-digit time values (7).
• {mm}—inserts the minute with a zero added to single-digit time values (07).
• {s}—inserts the second without zero added to single-digit time values (9).
• {ss}—inserts the second with zero added to single-digit time values (09).
• {User}—inserts the user name.
• {Mach}—inserts the computer name.
• {Dest}—inserts the destination application name.
• {Bttn}—inserts the button name.
• {Mode}—inserts the scan color mode.
• {Size}—inserts the page size.
• {BatchID}—inserts a unique batch identification number.

Technical Note

Some destination application links, such as the NewSoft Presto! BizCard software, require a specific filename 
format for the images that have been sent to the link to open correctly in the application. For example, when 
scanning duplex, if the image token {#03b} is not included in the filename, then each image sent will be regarded 
as a separate scan, and instead of one file with 2 pages you will have 2 files. As each destination application link is 
different, there is no standard filename type you can create to use for all destinations. If you scan and the images 
are not grouped in the file(s) as needed, try deselecting Use custom file naming and then scan again.
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SCAN CONFIGURATIONS

The scan configurations are where you select the scanning resolution, brightness, mode (color, black & white, or 
grayscale), and a number of other settings. To see a selected scan configuration’s settings, click its icon. Click the 
icon again to close the detailed information. 

NOTE: Use Configure Before Scan if you want to set the options manually before scanning. See Configure Before 
Scan on page 58.

Create a new configuration:

• Click the New button to create a new configuration starting with the OneTouch default configuration 
settings.

• Select a configuration in the list, then click on the Copy button to create a new configuration starting with 
the settings of the currently selected configuration.

Edit or delete a configuration:

Select the scan configuration you want to edit or delete. 

• To delete the configuration, click the Delete button.

• To edit the configuration, click the Edit button.

Edit the settings and click OK.

NOTE: Your scanner comes with a number of configurations pre-set at the factory. To ensure that your scanner will 
always have a set of correct scan configurations, do not delete the pre-set configurations. We also recommend 
that you keep those configurations locked so they are not inadvertently deleted. That way, you will always have 
the factory-settings available. If you do delete or edit them, and want to get the factory pre-sets back again, you 
will need to uninstall then re-install your scanner.

In the Scan Configuration Properties window, the Scan Settings, Page Settings, Advanced Settings, and 
Redaction Settings tabs are always available. When the Visioneer Acuity module is installed, the Acuity Settings 
tab will also be available for all destinations. 

Click the icon of a 
selected configuration to 
view its settings.

Select the scan 
configuration to edit or 
delete. It must be 
unlocked, as indicated by 
not having a lock 
displayed here.
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Based on the selected destination, additional settings tabs may also be available. If you see one of these 
additional settings tabs please refer to the appropriate section, as listed below, for instructions on configuring 
these destination specific options.

• Use the Storage Options tab to choose the storage folder for scans sent to the Transfer to Storage 
destination, as described on page 61.

• Use the Device Settings tab to configure Fax and Print destinations, as described on page 69.

• Use the PaperPort tab to choose the destination folder, in the Nuance PaperPort application, as described 
on page 71.

• Use the SharePoint tab to specify a SharePoint site, user credentials, and destination folder, as described on 
page 74.

• Use the FTP Transfer tab to specify an FTP site, user credentials, and destination folder, as described on 
page 77.

• Use the SMTP Configuration tab to specify an SMTP server, user credentials, and destination email address, 
as described on page 80.

SCAN SETTINGS TAB

On the Scan Configuration Properties dialog box, type a name. 

Mode—select a scanning mode:

• Black&White to scan in black and white. For example, letters and memos are usually scanned in black and 
white.

• Grayscale to scan items such as documents containing drawings or black and white photographs.

• Color to scan color photographs and other color items. Color scans have the largest file size.

Resolution—drag the slider to the right or left to adjust the dots per inch (dpi) of the resolution. The higher the 
dpi setting, the sharper and clearer the scanned image. However, higher dpi settings take longer to scan and 
produce larger files for the scanned images.

Brightness—sometimes an image is scanned with the brightness and contrast set too light or too dark. For 
example, a note written with a light pencil may need to be scanned darker to improve legibility. Increasing or 
decreasing the brightness makes the scanned image lighter or darker.

If the configuration 
is locked, click the 
lock to unlock it. The 
icon becomes a key.

Type a new name for 
the configuration.

Select the scan mode 
and drag the slider to 
set the resolution.

Drag the sliders to set 
the Brightness and 
Contrast.
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Contrast—the difference between the lighter and darker portions of the image. Increasing the contrast 
emphasizes the difference between the lighter and darker portions, decreasing the contrast de-emphasizes that 
difference.

Key and Lock icon—if you want to lock the configuration, click the key icon to change it from a Key to a Lock.

PAGE SETTINGS TAB

The options on the Page Settings tab will be available based on either the selected color mode (Black & White, 
Grayscale, or Color), or based on whether or not the scanner hardware supports the feature. 

Standard—click the menu arrow and choose a page size from the list.

Custom—enter the horizontal and vertical page dimensions in the boxes. Click the name of the units, inches or 
millimeters, to toggle between them.

Improvements and Settings—it is indicated in the feature description if there is a software or hardware 
dependency for the option to be available.

• Reduce Moiré patterns—moiré patterns are wavy, rippled lines that sometimes appear on the scanned 
images of photographs or illustrations, particularly newspaper and magazine illustrations. Selecting Reduce 
moiré patterns will limit or eliminate moiré patterns in the scanned image. This option is only available when 
scanning in Color or Grayscale at lower resolutions, and when the scanner supports this feature. 

If you are scanning using an Automatic Document Feeder, and the page is fed through at too great of an 
angle, the image may not straighten correctly. In that case, re-scan the page using the paper guides to feed 
the paper in straight. 

Click the name to 
toggle between 
inches and 
millimeters.
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• Invert image—reverses the color of each pixel in the scanned image. 

When scanning in black and white, each pixel is reversed from black to white and white to black. When 
scanning in grayscale each pixel is reversed to the opposite level of gray. When scanning in color each pixel 
is reversed to the opposite color in the color wheel.

• Skip blank originals—select this option to have the scanner detect if a blank page has been fed through 
the scanner, and remove it from the final file. Typically you might use this option when scanning a stack of 
two-sided pages which have a number of blank sides.

Sensitivity—you can adjust the sensitivity level of the blank image detection. 

Note that when the Options tab feature Use job separator in multi-page batch is enabled, and the option 
selected is When a blank page is detected, the sensitivity level for Skip Blank Originals is the sensitivity 
level that will be used when both features are enabled. 

Note that when the feature Use job separator in multi-page batch is enabled, and the option selected is 
When the number of images reaches, the blank originals are discarded before the images are counted. For 
example, if you scan 3 pages in duplex mode, each side of the page is counted as an image and the total 
number of images is 6. When Skip Blank Originals is enabled, and 2 of the 3 pages in the stack are blank on 
one side, the total number of images counted is 4 not 6.

• Manual Feed Mode—select this option to enable a delay from when the last page is scanned and when the 
scanner stops the scan job.

To scan with manual feed mode:

1. Select Manual feed mode.
2. In the Timeout field, input the amount of time you want the scanner to wait from when the last page is 

scanned and when the scanner stops scanning.
3. Place a document in the scanner.
4. Click Scan.
5. The scanning progress dialogue on-screen will display a countdown indicating how much time you 

have to place the next document in the scanner.
6. When you are done scanning all pages in your document, you can click on Abort to stop the timer or 

simply let the timer run out.

Original Image Inverted Image
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ADVANCED SETTINGS TAB

Use the Advanced Settings tab to set color correction options for Color or Grayscale scanning. Drag the sliders to 
the left and right to change the color settings. As you do, the image changes to show the effects of the new 
settings.

• Color saturation—the strength or purity of a color. This option is only available when the selected scan 
mode is Color.

• Color hue—the color your eyes see as reflected from the image. This option is only available when the 
selected scan mode is Color.

• Gamma—is the tone curve and the starting point for image enhancement. As you raise or lower the Gamma 
value, the values at which saturation, hue, brightness and contrast affect the image are changed. It is 
recommended that you keep the default Gamma value or adjust this setting before adjusting the other 
options. This option is available for both Color and Grayscale scanning.

REDACTION SETTINGS TAB

Use the options on the Redaction Settings tab to remove a specified area in the scanned image. 
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Please refer to the technical note, at the end of this section, for information about how this setting works with 
other options in the OneTouch Scan Configuration you are modifying. 

Enable redaction—select this option to enable redaction when scanning. You might use this option if you want 
to remove a logo or image that appears on each page that you are scanning. You can choose what color to fill in 
the redacted area in the scanned image, and set multiple areas. If you are scanning in Duplex mode, you can 
specify the area separately for the front and back side of the pages.

Click Add to add a line item to the area list in this window. You can redact multiple areas from the scanned image, 
click the Add button again to continue adding line items to the list. Select an item in the list then click the 
Remove button to remove the specified redaction area from the list.

Click one time on the default value, 0.00 in each field, to enable the control box for you to input the start position 
and redaction area size. The units of measurement is displayed on the lower-right corner next to the Paper size 
field.

• From left—input the upper-left corner start position measured from the left-side of the page.

• From top—input the upper-left corner start position measured from the top of the page. 

• Width—input the width of the area to be removed.

• Height—input the height of the area to be removed.
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Color—this color field shows the selected fill color for the redacted area(s). When the software removes the area 
you specify, it fills the area with the color you have selected here. To change the color, click the artist palette 
button to open the Windows color palette. Select the color you want then click on OK. The color you selected will 
now display in the Color field on the Redaction Settings tab.

Preview—this color field shows the actual color that will fill the redaction area in the final scanned image. When 
scanning in color, the Preview field will match the Color field. When scanning in Grayscale, the preview field will 
show the gray version of the color you selected, and that color will be in the final scanned image. When scanning 
in Black&White, the preview field will display black or white depending on the darkness of the color you selected, 
and the final image will have the redacted area(s) be black or white.

Technical Note

The options on the Page Settings tab will affect the redaction options as described below:

• On the Page Settings tab, click the name inches or mm to toggle between the two units of measurement. 
When you click back on the Redaction Settings tab, the lower-right corner displays the Paper size in the units 
of measurement you selected.

• Make sure the page size selected on the Page Settings tab is correct for the documents you are scanning, 
otherwise the redaction may not occur in the correct area.

Color 
scanning

Grayscale 
scanning

Black&White 
scanning
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• If Color dropout is selected, redaction occurs after the color specified is removed from the image. 

For example, if you selected Red as the color dropout, but then specify red for the redaction region, the final 
image will have the redacted region filled with gray when scanning Grayscale, or black or white when 
scanning in Black&White. 

Click the name to 
toggle between 
inches and 
millimeters.
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FILE FORMATS

The available file formats, in the Select format panel, are based on the selected destination for scanning. For 
example, if scanning to the destination Transfer to Storage, all file formats are available as the files are saved 
directly to a folder without opening any application. If the destination is an application, such as Microsoft’s Paint, 
only the file types the application supports will be available in the Select format panel. 

Most of the format icons have a right-click menu to select file format specific options, or choose additional 
formats that are not represented in the panel by default. 

The format names in the Select format panel indicates the file type extension for the scanned file.

CREATE SINGLE IMAGE FILES

The TIFF and PDF formats, as well as the text file formats, support multiple page documents in a single file. If you 
are scanning as a TIFF or PDF format, or as one of the text formats, and want one file created for each image 
scanned, select Create single image files. Note that this option is automatically selected and disabled if you have 
selected a format that only supports single pages, such as BMP, PNG, GIF, JPG, or JP2.

IMAGE FORMATS

Select an image file format for photos, artwork or other documents that you want to save as images. BMP and TIFF 
are standard image file formats generally used if you want to do additional image processing, such as photo 
touch-up or color correction. 

Image Formats. The BMP, JPG, 
and PDF image formats have 
right-click menu options.

Text Formats; TEXT 
is only one of several 
text formats 
available.
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Right-click on the BMP icon to access the GIF and PNG image formats. When you select either of these formats, 
the format panel will change the BMP icon to the selected image format icon.

Right-click on the JPG icon to access the JP2 image format. When you select JP2, the format panel will change the 
JPG icon to the JP2 format icon.

BMP—the *.bmp (bitmap) format is generally used when you want to do additional 
image processing, such as photo touch-up or color correction, as very little image 
compression is used when creating the file. When scanning in color or grayscale, BMP 
scans result in the largest file size of the image formats.
GIF—the *.gif (graphics interchange format) format is generally used when putting 
images on a website or server, as image compression can reduce the file size by 
approximately 95% when compared to a BMP file of the same image. Company logos 
and small pictures on a webpage are often GIF images. The GIF compression, and 
limited color range, can result in the medium and large images looking grainy or 
pixilated. 
PNG—the *.png (portable network graphics) format is another common image format 
for website graphics. Like GIF, the PNG compression greatly reduces the file size when 
compared to a BMP file of the same image. However, the PNG compression is different 
from GIF compression in that PNG images look better when scaled. Therefore, PNG is 
often used in place of GIF for company logos with a lot of detail, clickable buttons, 
medium sized pictures, and so on.
TIFF—the *.tif (tagged image file format) format is another image type that is often 
used for photo editing. When scanning in color, it produces a file of similar quality and 
size to a BMP file. However, when scanning in Black & White, the TIF compression 
produces the smallest file size of all the image types without losing image quality. TIFF 
also supports multi-page image files.

JPG—the *.jpg (joint photographic experts group) format is a common image format 
for transferring pictures electronically, such as posting to a website or sending via 
email, as JPG image files are smaller than BMP and TIFF files. You can change the level of 
compression for the picture file to have better quality or a smaller file size.
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To select a JPEG file size:

1. Select JPG as the page format. 

2. Right-click on the JPG icon.

A menu opens.

3. Choose the file size/image quality option for your scanned images.

Minimize Size—smallest file size, lowest image quality.

Normal—medium file size, some loss of image quality.

Maximize Quality—largest file size, minimal loss of image quality.

Your selection pertains only to the button currently selected on the OneTouch Properties window. Other 
buttons that have JPG selected as the file format are not affected, so you can set the JPG file size/image 
quality independently for each button.

4. Click OK or Apply on the OneTouch Properties window.

Right-click on the PDF format icon to change the image quality or select the option to make the scanned PDF file 
PDF-A compliant. 

To select a PDF file size:

1. Select PDF as the page format. 

JP2—the *.jpg2 (joint photographic experts group 2000) format is the new JPEG 
standard. This new JPG file type has improved compression for better image quality at 
smaller file sizes. Please refer to the official JPEG website at www.jpeg.org for more 
information about this file format, and a list of applications that can view and/or open 
this file type.

PDF—the *.pdf (portable document format) image format is often used to create 
images of text pages. The image compression of PDF files creates relatively small file 
sizes when scanning multiple page files in color. While the TIFF image format also 
supports multiple page files, when scanning in color the TIFF files are often too large to 
be transferred electronically. The PDF file format is often used for posting multiple page 
files to websites, sending via email, and permanent storage. As with the JPG file format, 
you can change the PDF quality to reduce the file size or improve the image quality. 
Adobe® Reader®, or other PDF viewer software, must be installed on your computer for 
you to view PDF files. 
Using PDF-A when scanning as PDF, means the files are compliant with the ISO-19005-1 
standard for permanent archival of electronic documents. More information about this 
standard can be found at www.pdfa.org.
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2. Right-click on the PDF icon.

A menu opens.

3. Choose the file size/image quality option for your scanned images.

Minimize Size—smallest file size, lowest image quality.

Normal—medium file size, some loss of image quality.

Maximize Quality—largest file size, minimal loss of image quality.

Your selection pertains only to the button currently selected on the OneTouch Properties window. Other 
buttons that have PDF selected as the file format are not affected, so you can set the PDF file size/image 
quality independently for each button.

4. Click OK or Apply on the OneTouch Properties window.

TEXT FORMATS

Selecting the text format option also selects OCR processing as an automatic step for scanning. Therefore, when 
you scan a document with the text format selected, the text portions of the document are automatically 
converted to editable text. 

Select a text format for documents with text or numbers, such as a business letter, report, or spreadsheet. The text 
format icon has several file formats available, depending on the Destination Application you select.

Detailed information about these text file formats, and instructions for setting up the OCR options, are in the 
section Scanning with Optical Character Recognition (OCR) on page 106.

To select a file type for the text format:

1. Select the Destination Application.
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2. Right-click on the text format icon. 

The menu options depend on the type of Destination Application you select.

3. Choose the file type that you want for the text format.

4. Click OK or Apply on the OneTouch Properties window.

Example menu for the Text format when 
the selected application is Microsoft’s Word 
and the OneTouch OmniPage Module is 
installed.

Example menu for the Text format when 
the selected application is Transfer to 
Storage and the OneTouch OmniPage 
Module is installed.
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CONFIGURE BEFORE SCAN

You can set up the scanner so that, when you put a page in, a different scanning interface opens before the 
scanning starts. You can then use the interface to change the Resolution, Scan Mode, and other settings. When 
you scan, the scanned image will still be sent as the file type and to the same Destination Application already 
selected in the One Touch Properties window for that button. To set up the scanner for this capability, you select 
Configure Before Scan from the scan configuration list.

The option Configure Before Scan can be used when you want to scan multiple pages and have them appear in 
one file.

1. Open the OneTouch Properties window.

2. Select the scan configuration Configure Before Scan. 

3. Click OK or Apply on the OneTouch Properties window.

TO SCAN USING CONFIGURE BEFORE SCAN

1. Place a document in the paper feed slot.

2. The TWAIN Interface opens.

3. Choose your scan settings, such as the Picture Type of Color, Grayscale or Black & White, Resolution in DPI, 
and Page Size.

4. Click the Scan button on the TWAIN Interface.

5. The item is scanned. When finished, click the Done button and the image will be sent to the Destination 
Application specified in the OneTouch Properties window.
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CREATING MULTIPLE PAGE FILES

You can use Configure Before Scan to create multi-page documents from individually scanned pages. 

NOTE: Using the Configure Before Scan option to scan multiple pages does not apply for page formats BMP and 
JPG. Please make sure the page format on the One Touch Properties window is set to TIFF, PDF, or one of the Text 
formats. Make sure the option Create single image files is not selected. Please see page 53 for instructions on 
changing the file settings.

1. Put a document in the paper feed slot on the scanner.

2. When the TWAIN Interface opens, select the appropriate scan settings for your document.

3. Click the Scan button on the TWAIN Interface.

4. After the Scanning Progress bar closes, place the next page in the paper feed slot on the scanner.

5. Continue until you have scanned all the pages in your multi-page document.

6. When you’re finished scanning, click the Done button on the TWAIN Interface.

7. All the scanned pages will be sent to the Destination Application set in the One Touch Properties window. If 
the Destination Application is PaperPort, the pages will be grouped as a single stack of pages.

Canceling a Configure Before Scan

1. Click Cancel in the scanning progress window.

2. The following window will open asking if you want to cancel the entire job.

• Yes—scanning stops and all pages scanned in this batch, up to this point, will be deleted. The TWAIN 
interface will close and you can restart your scan from the beginning.
Choose Yes if the TWAIN scan settings are incorrect for your current scanning batch. 
For instance, the Picture Type is Black & White but you want to scan your documents in color. Choose 
Yes to delete any scanned pages, then start over but select the correct picture type before scanning.

• No—scanning stops, but all pages scanned in this batch, up to this point, are not deleted and the 
TWAIN interface remains open. You can place a new page in the scanner, adjust the TWAIN settings for 
it, then click the Scan button in the TWAIN interface to continue scanning. At the end of the scanning 
batch, all pages from the first portion of the scan and second will be sent to the Destination 
Application. 
Choose this option if, for instance, you have been scanning a Black & White document but you want to 
insert a color page into it. Instead of having to re-scan the entire batch, you can stop the current scan, 
change the picture type from Black & White to Color, then restart the scanning without losing the 
pages already scanned.
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OPEN SCANNED DOCUMENT(S)

Select the destination Open Scanned Document(s) to have the scanned document open automatically when 
scanning is complete. 

Supported file types—all file formats are available when scanning to the Open Scanned Document(s) 
destination. Note that text file formats are only available if an OCR module or application is installed. Please refer 
to Text Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination type—the Open Scanned Document(s) destination is classified as a “Document Management Link”. 
To make it available in the destination list, you must select Document management on the Options tab in the 
OneTouch Properties window.

Technical Note

• If there is no application installed for the file format you selected, the OneTouch Link Log Viewer will open 
when scanning is finished showing the failure. You can double-click on the log failure to open the detail 
view of the failed transfer. 

For example, if you select PDF as the file type a PDF viewer application must be installed to open the file. 

Either install an application for that file type, or associate an application in the Windows Explorer folders 
option, please refer to your Windows documentation for instructions on associating file types. 

• When scanning to multiple destinations, the scanned file is still sent to the other selected destination 
application(s) in OneTouch. 
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TRANSFER TO STORAGE

With Transfer to Storage, you can scan documents and save them in a folder in one step. 

Supported file types—since the files are saved directly to a folder on the computer or server, all file formats in 
OneTouch are available. Note that text file formats are only available if an OCR module or application is installed. 
Please refer to Text Formats on page 56 to see a list of text file formats that are available when OCR is installed. 

Destination type—the Transfer to Storage destination is classified as a “Storage Link”. To make it available in the 
destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

SETTING THE FOLDER AND OPTIONS FROM ONETOUCH

In the OneTouch Properties window, select Transfer to Storage as the Destination Application for scanning. 

• Click the Properties button to open the OneTouch Link Properties for Transfer to Storage. From this window, 
you can change the global default storage location and options.

On initial installation of OneTouch, all scan configurations use these settings. When you create new 
configurations, the default settings will also match what you have selected here. If you modify the storage 
options in an individual configuration, changing the options in this Link Properties window will no longer 
update to the configurations you modified.
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• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on the Storage 
Options tab and use this window to set a configuration to scan to a different folder than the one selected in 
the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other 
configurations will retain their settings for this destination. 

Storage layout

• All documents are in the root—the scanned documents are saved in the root of the folder specified in the 
Storage location.

• Documents are put into folders by month, week, or type—folders are created based on your selection 
(month, week, or file type) and the scanned documents are saved in those folders. New folders are created 
for each month and week so you can keep track of when you scanned the documents. 

Storage location

• This is the location on the computer or network where the file will be saved. Click on the Browse button to 
change the location by browsing through your Windows folder list, or type a location directly into the input 
field. You can select a local folder, or a folder on a server or mapped drive.

Open storage folder when scan is complete

• Select this option to have the folder, specified in the Storage location, open when scanning is complete 
and the image has been transferred to that location. If you have selected a month, week, or type grouping 
option, the folder that opens will be the grouping option you selected. 

SETTING THE FOLDER FROM WINDOWS

When OneTouch was installed, a storage option was added to the right-click menu of your Windows folders. This 
menu option allows you to set the Transfer to Storage folder location without opening OneTouch first. 

1. Right-click on the folder you want set as the scan destination.

Transfer to Storage OneTouch Link 
Properties window

Scan Configuration Properties window - 
Storage Options tab
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2. Hover the mouse cursor over the Set as scan destination option and the sub-menu will open to the right. 
Click on the setting you want the Storage location to be updated with. 

• For all configurations—select this option to have the storage location, in all scan configurations 
Storage Options tabs, updated to use this location. Note that the storage Link Properties location will 
also update to use this location.

• For new and default configurations—select this option to have the OneTouch Link Properties 
storage location updated. Any scan configurations that you have not previously updated, with custom 
storage locations, will also use this location.

• For configuration used by a button—when you select this option, another sub-menu will open to the 
right. The sub-menu will contain a list scanner buttons that are currently set to scan to the Transfer to 
Storage destination. Select the button you want updated to use this location. This option modifies only 
the scan configuration that is assigned to the button you select. If you have multiple OneTouch 4.6 
scanners installed, the first sub-menu will show a list of the currently connected scanners for you to 
select which scanner to update.
Note that this option is disabled if there is no scanner plugged in and turned on. 

SCANNING TO MULTIPLE FOLDERS

When archiving documents with Transfer to Storage option, you can scan the documents to different folders. For 
example, one folder might be for “Business Receipts,” a second folder might be for “Personal Receipts,” and a third 
folder might be for “Annual Receipts.”

To scan to multiple folders, you create multiple configurations, each with a different storage location for the 
scanned documents. Scan one set of documents using the scan configuration with the appropriate storage 
location for that set. Then switch to another scan configuration and scan the next set of documents to store them 
in their folder.

Setting Up Multiple Folders for Transfer to Storage

1. Using Microsoft Windows, create the folders that you want to use for storing scanned items. 

2. Open the OneTouch Properties window.

3. Select Transfer to Storage as the Destination Application.



VISIONEER ROADWARRIOR 3 SCANNER USER’S GUIDE64
4. Click the New button.

The Scan Configuration Properties dialog box opens.

5. To help you remember which folder it is, give the new configuration a name that indicates the folder name, 
such as “Business Receipts.”

6. Click the Scan Settings, Page Settings, and Advanced Settings tabs, and select the settings you want.

7. Click the Storage Options tab.

8. Click the Browse button.
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9. Select the folder you created for storing the scanned documents.

10. Click OK. The selected folder will now be set as the Storage location, such as “Business Receipts.”

11. Click OK. The new configuration is now listed as a Transfer to Storage configuration.

12. Repeat the process to create additional new configurations, such as one named “Personal Receipts.”

NOTE: Make sure to designate separate folders as the Storage Locations for each new configuration.
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13. You will now have multiple configurations set up for the Transfer to Storage destination, and each 
configuration scans documents to separate folders.

14. Now select a scanner button for each new configuration. Click Apply to set that button for that 
configuration.

Scan to multiple storage folders:

1. Open the One Touch Properties window.

2. Select one of the configurations you created for storage.

3. Click OK. The One Touch Properties window closes.

The One Touch panel will show the name of the configuration.

4. Scan the documents you want to store.

The documents are scanned to the folder specified for the configuration.

5. When scanning is finished, open the One Touch Properties window again and select the other configuration 
you created for storage.

6. Click OK.

The One Touch panel will show the name of the other configuration.

7. Now scan the next set of documents.

When scanning is finished, the two sets of documents are stored in the two separate folders.

The new configurations 
apply to the Transfer to 
Storage Destination 
Application.
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BURN TO CD-ROM 

If you have a CD burner attached to your computer, you can scan directly from your scanner onto a CD. This 
feature is available only on computers running Windows version XP or later. 

Supported file types—since the files are going to be burned to a CD, all file formats in OneTouch are available. 
Note that text file formats are only available if an OCR module or application is installed. Please refer to Text 
Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination type—the Burn to CD-ROM destination is classified as a “Storage Link”. To make it available in the 
destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

1. Open the OneTouch Properties window.

2. Select Burn to CD as the Destination Application. 

3. Choose a File Format and a Scan Configuration.

4. Click OK.

5. Now start scanning using the scanning button you set to scan and burn to a CD.

The scanner will start scanning. When finished the file will be saved to the Windows temporary location for 
CD files. An information bubble will appear in the Windows notification area telling you that there are files 
waiting to be burned to CD.
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6. When you are ready to burn the files to a CD, open the OneTouch Properties window, select Burn to CD and 
then click the Properties button. 

7. Make sure a blank CD is in the CD burner.

8. Click the Burn to CD button. The CD burner begins and your scanned documents are written to the CD.

If other files are also waiting in this location, they will get written with the OneTouch files on the CD.
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PRINTER OR FAX

The availability of printers and/or faxes in the OneTouch destination list depends on whether or not you have 
printers or faxes configured in Windows. Please refer to the Windows documentation, or your printer or fax 
documentation, for setting up printers and faxes. 

Supported file types—only the BMP file format is available, when scanning to a printer or fax, as only 
uncompressed data can be send to these devices.

Destination type—printers and Faxes are classified as “Device Links”. To make them available in the destination 
list, you must select Fax and Print on the Options tab in the OneTouch Properties window.

The Properties button will be disabled in OneTouch as there are no global properties for this type of destination. 

Select a printer or fax device, in the Select destination list, then open a Scan Configuration to modify the settings 
for the device you selected.

Click on the Device Settings tab and use the options on this tab to select settings for the device.
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• Fit to page, reduce image if necessary—if the scanned image is too big to be printed or faxed on a single 
page, the image will automatically be reduced to fit the page.

• Actual size, crop image if necessary—if the scanned image is too big to be printed or faxed on a single 
page, the image will automatically be cropped around its edges to fit on the page.

• Center image on page—the image will be printed in the center of the page instead of at the top left corner.

• Maintain aspect ratio—the aspect ratio is the length-to-width relationship of the image’s dimensions. 
Select this option so the image’s relative proportions remain constant.

• AutoRotate image for best fit—if the image is a Landscape format and the device is printing in the Portrait 
mode, or vice versa, rotate the image to fit on the page.

• Collate copies—if you are printing more than one page, collate the copies. Enter the number of copies in 
the Copies box.

• Advanced—click to see additional settings for the device. The dialog box that opens is specific to the 
device. For example, if the device is your printer, the dialog box is your printer’s setup settings.

NOTE: When scanning to multiple printers and/or faxes, select the specific device, you want to configure the 
Advanced features for, from the list before clicking on the Advanced... button.
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PAPERPORT

In the OneTouch Properties window, select PaperPort as the Destination Application for scanning. 

Supported file types—all image file formats are available when scanning to PaperPort. The sPDF and nPDF text 
file formats are only available when the OmniPage software or OneTouch OmniPage module is installed. Please 
refer to Text Formats on page 56.

Destination type—the PaperPort destination is classified as a “Document Management Link”. To make it 
available in the destination list, you must select Document management on the Options tab in the OneTouch 
Properties window.

• Click the Properties button to open the OneTouch Link Properties for PaperPort. From this window, you can 
change the default folder location and options.

On initial installation of OneTouch, all scan configurations send the scanned document to the folder selected 
in this window. When you create new configurations, the default settings will also match what you have 
selected here. If you modify the options in an individual configuration, changing the options in this Link 
Properties window will no longer update to the configurations you modified.
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• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on the 
PaperPort tab and use this window to set a configuration to scan to a different folder than the one selected 
in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other 
configurations will retain their settings for this destination. 

Select the destination folder for Scanned Documents

• Select a folder to send the scanned document(s) to when scanning to the PaperPort destination.

The list of folders in this window are from the PaperPort Folder Manager. Use the PaperPort Folder Manager 
to add or delete folders, add other drives and network locations to this list. You cannot add new folders from 
the OneTouch PaperPort configuration windows.

PaperPort OneTouch Link Properties 
window

Scan Configuration Properties window - 
PaperPort tab
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Scan to the current PaperPort folder

• Select this option to have the scanned document(s) sent to the currently selected folder in the PaperPort 
application.

The PaperPort software must be open, before scanning, for the scans to be sent to the selected folder in the 
PaperPort folder pane. If PaperPort is not open, this option is ignored and the scanned file is sent to the 
folder selected in either the OneTouch Link Properties or Scan Configuration window for PaperPort.

These are the folders that are 
available in the OneTouch PaperPort 
configuration windows. Press F1 on 
your keyboard to open the PaperPort 
help file for instructions on managing 
this folder list.

Click the folder icon to open or close 
the folder list in PaperPort.

The selected folder in this list is where 
the scanned file will be saved when 
PaperPort is open and the OneTouch 
option Scan to the current PaperPort 
folder is selected.
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SHAREPOINT

The SharePoint destination link allows scans to be sent directly to a SharePoint site from OneTouch. Please 
contact your SharePoint site administrator for the server information you need to configure this link. Alternatively, 
have your site administrator or IT professional configure this link for you. Setup and configuration of the 
SharePoint sites and user accounts are outside the scope of this document.

Supported file types—all image and text file formats, except HTML, are available when scanning to the 
SharePoint site. Note that text file formats are only available if an OCR module or application is installed. Please 
refer to Text Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination type—the SharePoint destination is classified as a “Storage Link”. To make it available in the 
destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window. 

All configuration of the SharePoint server is done using the SharePoint settings tab in the Scan Configuration 
Properties window. 

1. Select SharePoint as the destination application.

2. Open the Scan Configuration you want to modify for scanning to a SharePoint site, or create a new Scan 
Configuration.

Select an existing configuration in which you have already specified your SharePoint site information, and 
then click on the Copy button to create a new configuration using the settings of the current configuration. 
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3. Click on the SharePoint tab and fill in the fields with the information for your SharePoint site.

• Protocol—select which protocol you want to use to transfer the scan to the server.

• SharePoint URL—input the full URL path of the SharePoint site without the http(s):// designation and actual 
page. This path should include everything except the destination folder. 

For example, if the web browser URL displays http://sharepoint.site.com/IT/common/shared documents/
default.aspx, then you would configure the SharePoint server path as follows:

• Select HTTP as the protocol
• The SharePoint URL would be sharepoint.site.com/IT/common
• The Destination folder would be shared documents 

• User account—input the user account name that has privileges to save files to the specified SharePoint site 
and Destination folder.

• Password—input the password for the user account name you specified.

• Use Windows Integrated Authentication—select this option to use the Windows current user’s login 
name and password to access the SharePoint site.

• Destination folder—this is the folder where the final scanned document(s) are transferred to when 
scanning is complete.

• Filename format—select a file naming format, for the scanned document, from the list. Select “Use custom 
file naming” to use the file you set on the Options tab in the OneTouch Properties window.

Count—this field will enable when the selected Filename format contains {seq}. Input the number you want 
the sequential count to start from.

Filename prefix—this field will enable when the selected Filename format contains {prefix}. Input the name 
or value you want as the prefix in the final file name.

Because the destination configuration is done through the scan configuration, you can set each configuration to 
scan to different SharePoint site, folder, filename format, using different user credentials, and so on. This is the 
same process used as when scanning to different folders using the Transfer to Storage destination, as described in 
detail starting on page 63.

Click on the Help button, in this configuration tab, to launch the SharePoint help file. The help file contains 
detailed information about the settings in this window and technical implementation notes.
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SHAREPOINT LINK LOG VIEWER

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to 
View logs for and select SharePoint Link from the list to display the transfer history for the SharePoint link only. 

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed 
transfer, the log file may contain the information you need to determine why the transfer failed. After you address 
the failure indicated in this log file, you can click the Retry button to resend the document to the server.

Click on the Properties button to open the Log Viewer from the SharePoint OneTouch Link Properties window. 
There are no global configuration properties for the SharePoint destination application, all configuration is done 
using the Scan Configuration Properties window as described in the previous section.
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FTP TRANSFER

The FTP Transfer destination link allows scans to be sent directly to an FTP server from OneTouch. Please contact 
your server administrator for the server information you need to configure this link. Alternatively, have your site 
administrator or IT professional configure this link for you. Setup and configuration of the FTP server and user 
accounts are outside the scope of this document.

Supported file types—all image and text file formats, except HTML, are available when scanning to an FTP 
server. Note that text file formats are only available if an OCR module or application is installed. Please refer to 
Text Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination type—the FTP Transfer destination is classified as a “Storage Link”. To make it available in the 
destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window. 

All configuration of the FTP server is done using the FTP Transfer tab in the Scan Configuration Properties 
window. 

1. Select FTP Transfer as the destination application.

2. Open the Scan Configuration you want to modify for scanning to an FTP server, or create a new Scan 
Configuration.

Select an existing configuration in which you have already specified your FTP server information, and then 
click on the Copy button to create a new configuration using the settings of the current configuration. 
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3. Click on the FTP Transfer tab and fill in the fields with the information for you FTP server.

• Protocol—select which protocol you want to use to transfer the scan to the server.

• Host—input the internet or intranet path of the server where you want to send the scanned documents. 
you do not need ftp:// at the beginning. For example, ftp.company.com

• Port—input which port to use with the selected protocol. Changing the selected protocol will reset this 
value to the appropriate default for the protocol.

• User account—input the user account name that has privileges to save files to the specified host 
destination folder.

• Password—input the password for the user account name you specified.

• Destination folder—input the folder path, on the remote FTP server, where you want the scanned 
documents sent. This path would appear in your web browser after the host name. For example, marketing/
shared documents/data sheets. 

Because the destination configuration is done through the scan configuration, you can set each configuration to 
scan to a different FTP server, destination folder, and so on. This is the same process used as when scanning to 
different folders using the Transfer to Storage destination, as described in detail starting on page 63.

FTP LINK LOG VIEWER

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to 
View logs for and select FTP Link Agent from the list to display the transfer history for the FTP link only. 
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Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed 
transfer, the log file may contain the information you need to determine why the transfer failed. After you address 
the failure indicated in this log file, you can click the Retry button to resend the document to the server.

Click on the Properties button to open the Log Viewer from the FTP OneTouch Link Properties window. There are 
no global configuration properties for the FTP destination application, all configuration is done using the Scan 
Configuration Properties window as described in the previous section.
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SMTP 

The SMTP destination link allows scans to be sent directly to an email address, through an SMTP server, from 
OneTouch. Please contact your server administrator for the server information you need to configure this link. 
Alternatively, have your site administrator or IT professional configure this link for you. Configuration of the SMTP 
server settings and user accounts is outside the scope of this document.

Supported file types—all image and text file formats, except HTML, are available when scanning to an SMTP 
server. Note that text file formats are only available if an OCR module or application is installed. Please refer to 
Text Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination type—the SMTP destination is classified as a “Email Link”. To make it available in the destination list, 
you must select Email on the Options tab in the OneTouch Properties window. 

All configuration of the SMTP server is done using the SMTP Settings tab in the Scan Configuration Properties 
window. 

1. Select SMTP as the destination application.

2. Open the Scan Configuration you want to modify for scanning to an SMTP server, or create a new Scan 
Configuration.

Select an existing configuration in which you have already specified your SMTP server information, and then 
click on the Copy button to create a new configuration using the settings of the current configuration. 
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3. Click on the SMTP Settings tab and fill in the fields with the information for you SMTP server.

• Protocol—select which protocol you want to use to transfer the scan to the server.

• Host—input the internet or intranet path of the server where you want to send the scanned documents. For 
example, smtp.company.com

• Port—input which port to use with the selected protocol. Changing the selected protocol will reset this 
value to the appropriate default for the protocol.

• User account—input the user account name that has privileges to send email messages through the SMTP 
server. 

• Password—input the password for the user account name you specified.

• Use Windows Integrated Authentication—Select this option to use the Windows current user’s login 
name and password to send the message through the SMTP server.

• Email to—input a valid recipient email address to receive the scanned document. If it is not a valid address 
the transfer will fail.

• Email from—input the email address you want to appear in the email message “from” field. 

• Limit (MB)—input the maximum message size limit set on the SMTP server. This number should be lower 
than or match the SMTP server maximum. You cannot send messages that exceed the maximum message 
size of the SMTP server. 

Because the destination configuration is done through the scan configuration, you can set each configuration to 
scan to a different SMTP server, send messages to different email addresses, using different user credentials, and 
so on. This is the same process used as when scanning to different folders using the Transfer to Storage 
destination, as described in detail starting on page 63.

Click on the Help button, in this configuration tab, to launch the SMTP help file. The help file contains detailed 
information about the settings in this window and technical implementation notes.
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SMTP LINK LOG VIEWER

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to 
View logs for and select SMTP Link Agent from the list to display the transfer history for the SMTP link only. 

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed 
transfer, the log file may contain the information you need to determine why the transfer failed. After you address 
the failure indicated in this log file, you can click the Retry button to resend the document to the server.

Click on the Properties button to open the Log Viewer from the SMTP OneTouch Link Properties window. There 
are no global configuration properties for the SMTP destination application, all configuration is done using the 
Scan Configuration Properties window as described in the previous section.
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EMAIL APPLICATIONS

Scanning to an email application, such as Outlook or Windows Mail, attaches the scanned image to a blank email 
message. You then fill in the recipient email address(es) and send the message. You need to have configured an 
email application before you can scan to it using OneTouch. If you do not have your email application set up prior 
to scanning, the default Windows email application will open and ask you to configure your user information. 
Please contact your IT department, server administrator, or other group that provided you the email information 
for setup instructions. Configuring an email application and user account is outside the scope of this document.

Supported file types—all image and text file formats, except HTML, are available when scanning to an email 
application. Note that text file formats are only available if an OCR module or application is installed. Please refer 
to Text Formats on page 56 to see a list of text file formats that are available when OCR is installed.

Destination types—the email destination is classified as an “Email Link”. To make it available in the destination 
list, you must select Email on the Options tab in the OneTouch Properties window. 

The email application in the OneTouch destination list is the default email program selected in the Internet 
Options of Internet Explorer. Click on the email application that is in the list, then click on the Properties button 
to launch the Email OneTouch Link Properties window to change the email application. 



VISIONEER ROADWARRIOR 3 SCANNER USER’S GUIDE84
EMAIL PROPERTIES

Use the Email Link Properties window to select a folder for storing a permanent copy of the scanned image, 
setting the color document options, and changing the email application that is in the OneTouch destination list. 

• Folder for storing attachments—click the Browse button to change the location using the Windows file 
browser, or type a location directly in the field.

• Internet options—if you need to change your email client, or any other internet options, click the Internet 
Options button.

The Windows Internet Options Control Panel opens. Click the Programs tab and choose a new email client 
from the program list. These are the standard Windows Internet Explorer options. Please see your Windows 
documentation for more information about the Internet Explorer options.

Color document handling—click in the Color document handling settings boxes for the options you want.

• Convert Bitmaps using Screen Resolution—use this option to ensure that an image will fit on the 
computer’s screen. 

• Convert Bitmaps to JPEG—JPEG files can be compressed to produce smaller files sizes and, therefore, 
shorter transmission times when you email the file or upload it to the internet.

If you changed the email application Internet Explorer, and it does not immediately appear in the Select 
destination list, click the Refresh button to update the destination list in OneTouch. 
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TEXT EDITORS

Scanning to a text editing application, such as Microsoft’s Notepad or WordPad, automatically converts the text in 
the scanned image into editable text using Optical Character Recognition (OCR). 

Supported file types—the text file formats and destination applications are only available if an OCR module or 
application is installed. Please refer to Text Formats on page 56 to see a list of text file formats that are available 
when OCR is installed. Additionally, the available file formats are application specific, for example Microsoft’s 
WordPad can open *.txt and *.rtf files, so only those two file types will be available when scanning to WordPad. 

Note that when there is no OCR module or application installed, the format panel will not contain a text icon and 
there will be no text editor applications in the Select destination list. 

Destination type—this destination type is classified as a “Text Based Link”. To make it available in the destination 
list, you must select Text editing applications on the Options tab in the OneTouch Properties window. If the text 
editing application you are using does not appear in the Select destination list, you can add the application using 
the Text Documents OneTouch Link Properties window. 

1. In the OneTouch Properties window select one of the default text editors such as WordPad.

2. Click on the Properties button to open the Text Document OneTouch Link Properties window. From this 
window you can select what OneTouch should do when text is not detected or recognition fails, and add 
other applications to OneTouch.

Note that if you recently installed an application, click the Refresh button to see if OneTouch will 
automatically configure the link before you try adding it manually.
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TEXT DOCUMENTS PROPERTIES

These properties apply to Microsoft Word, Microsoft Excel®, and any other text editing applications indicated by 
their icons in the list.

• Add application—click this button to open the Add Text Based Link dialogue so you can add other text 
editing applications to OneTouch. 

• Delete application—select an application in the list then click this button to remove the application from 
the OneTouch destination list. You can only delete an application that you have added, the destinations that 
are linked when OneTouch is installed cannot be deleted.

General OCR settings—click in the OCR settings boxes for the options you want. The options will apply to all the 
applications in the group. 

• Always send a file, even when no text was found—the scanned file is sent to the application even if the 
image does not appear to contain text. This could occur if you scanned a photograph with a scanner button 
set for text applications.

• Show message if text recognition failed—a message will open on the screen if the OCR reader does not 
detect text in the image.
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ADDING TEXT EDITOR APPLICATIONS TO ONETOUCH

1. To add another application to the list, click the Add application button. The Add Text Based Link dialog box 
opens.

2. Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically 
filled in, and the application icon appears in Step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.

4. In Step 4 of the dialog box, select the file formats that the application will accept. 

• HTML Formatted file—select this option when you want to scan to your web browser for posting 
HTML pages to a website. Even though word processing applications, such as Notepad and Word can 
open *.htm files, you cannot scan as *.htm to word processing text editors. Scanning as HTML creates a 
directory with the *.htm file and linked images for website use. Word processing applications cannot 
accept a directory structure for image and text transfer.

• Rich Text Format—select this option if your application can open *.rtf files, which are plain text 
documents that contain formatting. Microsoft’s WordPad application is a compatible application for 
the *.rtf file formation.

• Standard ASCII text file—select this option if you want to have plain text, without formatting, sent to 
your text editing application. Most text editing applications will accept plain text (*.txt) files.

• Adobe PDF format—select this option if you are adding a PDF viewing or editing application to the 
list. This PDF format is an image format only, it will not recognize the document using OCR, and you will 
not be able to search or edit the text in the final file. The application you are adding must be able to 
open *.pdf files.

• Adobe searchable PDF—this is the PDF image format with a hidden searchable text layer. You will not 
be able to edit the text the file. The application you are adding must be able to open *.pdf files.
The options you select at Step 4 determine the page format icons in the OneTouch Properties window 
for that group of applications. Refer to the documentation you received with the application to see 
which text formats the application accepts. 

5. When you are done making changes in this window, click the Add button to accept the changes and close 
the window. 
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6. Click OK on the Link Properties window.

7. Click Refresh on the OneTouch Properties window and the new application should now be available.

CREATING AN HTML WEB PAGE FROM YOUR SCANNED DOCUMENTS

1. Open the OneTouch Properties window. 

2. Select your web browser as the Destination Application and choose HTML as the Format.

3. Choose a Scan Configuration that has the settings for how you want any images, on the pages you are 
scanning, to be displayed. For example, choose a color or grayscale scan configuration if your documents 
contain images that you want posted to your website with the HTML text. 

4. Click OK.

5. Start scanning using the button you selected for scanning with the HTML format.

When scanning is finished, the document is first converted to editable text using the OCR process, then 
converted into an HTML format. Any images detected by the OCR engine are isolated and linked as *.gif files.

6. Microsoft Internet Explorer, or other web browser you scanned to, then opens showing your converted 
page. The application’s URL field shows the location where OneTouch saved the HTML files for you to locate 
and post to your website.

Choose 
HTML
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STILL IMAGE CLIENT

If you want to specify an application to use for scanning at the start of the process, you can use event forwarding. 

Supported file formats—you cannot select a file format when scanning to the Still Image Client as the 
destination application is not selected until after you start scanning.

Destination type—the Still Image Client destination is classified as an “Event Forward Link”. To make it available 
in the destination list, you must select STI event forwarding on the Options tab in the OneTouch Properties 
Window.

Please note that if you have turned on the option to scan to multiple destinations, the Still Image Client 
destination cannot be selected. Please click on the Options tab and deselect Enable scanning to multiple 
destinations to proceed with scanning to this destination.

1. Open the OneTouch Properties window, and select Still Image Client as the Destination Application.

2. Choose a Scan Configuration and click OK.

3. Start scanning using the button you selected for event forwarding.
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4. A dialog box opens for you to select the application to use for scanning. Select the application you want in 
the box and click OK.

Now the application you selected opens and you can continue scanning using that application’s interface. 

Technical Note

If the scanner scans and sends an image to an application without prompting you to choose an application to run, 
the control panel options for your scanner’s events are automatically set to run a specific program when an event 
is initiated. Follow these steps to change the events setting for your scanner.

1. Open the Windows Control Panel.

2. Open the Scanners and Cameras group.

When the Control Panel is in Classic View, the Scanners and Cameras group will be in the list.

When the Control Panel is in Category View (Windows XP), or Home View (Windows Vista, 7 and 8), the 
Scanners and Cameras group will be located under either of the following main groups:

• Windows XP—Printers and Other Hardware
• Windows Vista, 7 and 8—Hardware and Sound

3. Open the scanner properties window.

• Windows XP—click on the scanner icon and then click on the View device properties link on the left side 
of the window.

• Windows Vista, 7 and 8—click on the scanner icon and then click on the Properties button.
4. Click on the Events tab.

5. Select the option Prompt for which program to run to be prompted when scanning to Still Image Client. 
Alternatively, select Start this program then choose an application from the list to have that application 
start each time you scan to Still Image Client. 

6. Click on OK when you are done making changes to this window.

7. Now when you scan with Event Forwarding you will either be prompted to choose an application, or the 
default application you selected will open.
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IMAGE EDITORS

Image editors include Microsoft Paint and other drawing and graphics applications. 

Supported file formats—the available file formats are based on the selected destination application. For 
example, you can scan to Microsoft’s Paint application as a BMP, GIF, PNG, or JPG, but not as TIFF or JP2 as Paint 
cannot open those two file types. Please refer to Image Formats on page 53 for more information on which image 
formats OneTouch supports.

Destination type—this destination type is classified as a “Simple Image Link”. To make it available in the 
destination list, you must select Image editors (i.e. Paint) on the Options tab in the OneTouch Properties window. 
If the image editing application you are using does not appear in the Select destination list, you can add the 
application using the Image Documents OneTouch Link Properties window. 

1. In the OneTouch Properties window select one of the default image editors such as Microsoft Paint.

2. Click on the Properties button to open the Image Documents OneTouch Link Properties window.

From this window you can add an application and set additional document handling options.

Note that if you recently installed an application, click the Refresh button to see if OneTouch will 
automatically configure the link before you try adding it manually.
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IMAGE DOCUMENTS PROPERTIES

These properties apply to Microsoft Paint and other image processing applications.

• Add application—click this button to open the Add Simple Image Link dialogue so you can add other 
image editing applications to OneTouch. 

• Delete application—select an application in the list then click this button to remove the application from 
the OneTouch destination list. You can only delete an application that you have added, the destinations that 
are linked when OneTouch is installed cannot be deleted.

Color document handling—click in the Color document handling settings boxes for the options you want. 
These options will apply to all the applications in the group.

• Convert Bitmaps using Screen Resolution—use this option to ensure that an image will fit on the 
computer’s screen. When a computer screen is set to a lower resolution, bitmap images with a higher 
resolution may be too big to fit on the screen. Converting the bitmap image to match the screen resolution 
ensures that the image fits on the screen.

• Convert Bitmaps to JPEG—JPEG files can be compressed to produce smaller file sizes and, therefore, 
shorter transmission times. Use this option to provide that compression capability to image files.
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ADDING IMAGE EDITOR APPLICATIONS TO ONETOUCH

1. To add another application to the list, click the Add application button. The Add Simple Image Link dialog 
box opens.

2. Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically 
filled in, and the application icon appears in Step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.

4. In Step 4 of the dialog box, select the file formats that the application will accept. 

• Windows Bitmap File—select this option if you want to scan to your image application as a BMP file. 
This format creates the largest file size as the final scanned image has not been compressed.

• Tagged Information File—select this option if your application supports TIF image files. The TIF file 
format supports multiple pages in a single file.

• JPEG Compressed File—this is a compressed image format that is often used when sharing 
photographs and scanned images electronically as the file size is smaller than a BMP.

• Compugraphics File—select this option if your application supports GIF images. This file format is 
often used for icons and small images on a web page.
The options you select at Step 4 determine the page format icons in the OneTouch Properties window 
for that group of applications. Refer to the documentation you received with the application to see 
which text formats the application accepts. 

5. When you are done making changes in this window, click the Add button to accept the changes and close 
the window. 

6. Click OK on the Link Properties window.

7. Click Refresh on the OneTouch Properties window and the new application should now be available.
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PDF APPLICATIONS

PDF destinations are applications that can open and/or edit the Adobe PDF file format. 

Supported file types—applications in the PDF destination group support the *.pdf file format. When the 
OmniPage module or software is installed, OneTouch includes an option to scan as sPDF or nPDF. Selecting either 
of these two formats still creates a *.pdf file, but the “s” and “n” letters indicate that OCR will process the image 
before sending the file to the PDF application. 

• sPDF—this format creates a *.pdf file that contains the original image of the scanned page, with a hidden 
text layer that allows you to search for text in the file.

• nPDF—this format creates a *.pdf file that can be edited in a PDF application. Any pictures in the scanned 
image are isolated from the text, the text on the page is recognized and turned into editable text, and the 
pictures are placed back into the document in the same flow as the original document. 

Destination type—this destination type is classified as “PDF Link”. To make it available in the destination list, you 
must select PDF applications on the Options tab in the OneTouch Properties window.

If the PDF application you are using does not appear in the Select destination list, you can add the application 
using the Text Documents OneTouch Link Properties window. 

1. Click on the Options tab in the OneTouch Properties window.

2. Make sure PDF applications and Text editing applications are selected then click back on the button tab.

Please note that any PDF application you add manually to OneTouch will be classified as a “Text Based Link.” 
These applications will only show in the destination list when Text editing applications are enabled.
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3. Click on one of the default text editors such as WordPad.

4. Click on the Properties button.

5. To add another application to the list, click the Add application button. The Add Text Based Link dialog box 
opens.

6. Click Browse to find the application you want to add to the list.

When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically 
filled in, and the application icon appears in Step 3.

7. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.
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8. In Step 4 of the dialog box, select Adobe PDF format and Adobe searchable PDF. 

Adobe PDF format—select this option if you are adding a PDF viewing or editing application to the list. This 
PDF format is an image format only, it will not recognize the document using OCR, and you will not be able 
to search or edit the text in the final file. The application you are adding must be able to open *.pdf files.

Adobe searchable PDF—this is the PDF image format with a hidden searchable text layer. You will not be 
able to edit the text the file. The application you are adding must be able to open *.pdf files.

The options you select at Step 4 determine the page format icons in the OneTouch Properties window for 
that group of applications. Refer to the documentation you received with the application to see which text 
formats the application accepts. 

9. When you are done making changes in this window, click the Add button to accept the changes and close 
the window. 

10. Click OK on the Link Properties window.

11. Click Refresh on the OneTouch Properties window and the new application should now be available.
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SEND TO APPLICATION

The Send to Application link allows you to select any application on your computer as the scan destination. 

Supported file types—all file formats in OneTouch are available when scanning to this destination. After you 
configure the link, as described below, make sure you select a file format that the application can open. Please 
refer to Text Formats on page 56 to see a list of text file formats that are available when OCR is installed. 

Destination type—this destination type is classified as “Document Management Link”. To make it available in the 
destination list, you must select Document Management on the Options tab in the OneTouch Properties 
window.

You must configure this destination before attempting to scan to it the first time. If you scan without configuring 
the link first, the OneTouch log viewer will open and show that sending the image to the Send to Application 
link failed. 

• Click the Properties button to open the OneTouch Link Properties for the Send to Application link. From 
this window, you can configure the default application for this link.

After configuring the link properties, all of the default scan configurations will immediately update to send 
to the application you specify in this window. When you create new configurations, the default settings will 
also match what you have selected here. If you modify the options in an individual configuration, changing 
the options in this Link Properties window will no longer update to the configurations you modified.

• Click the New, Copy, or Edit button to open the Scan Configuration Properties window. Click on the Send to 
Application tab and use this window to set a configuration to scan to a different application than the one 
selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other 
configurations will retain their settings for this destination. 
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To configure a destination application for the Send to Application link:

1. Click Browse to open the Windows file browser and navigate to the location of the application’s executable 
(*.exe) file. 

In most cases, the application’s directory is located in the programs directory on the C:\ drive. Because you 
can select any executable file, make sure you select an application that can receive image or text files.

2. Select the application’s *.exe file then click on Open. 

The application’s *.exe file path will now show in the Application path field.

3. Click on OK to close the window.

For basic scanning, you do not need to adjust any of the other settings in this window. The default settings 
will work with most applications. The advanced settings are described below.

4. Select a file format and scan configuration in the OneTouch Properties window.

If you select a text file format, the scanned image is converted into editable text before being sent to your 
selected application.

5. Click on OK to close OneTouch.

6. Put the document(s) in the scanner and start scanning with the button you set to use the Send to 
Application destination.

7. The scanner starts scanning and, when finished, sends the scanned file to the application you selected.

Technical note

• After configuring this link, you may need to click Refresh in the OneTouch Properties window to show the 
correct application icon in the Select destination list.

Send to Application OneTouch Link 
Properties window

Send to Application Scan Configuration 
Properties window
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Configure advanced features—select this option to change the default settings for this link. Only advanced 
users and application developers should modify these settings.

• Launch application for every image—when this option is selected, the application will open one time for 
each image scanned. You should deselect this option only if the application you are scanning to will accept 
multiple page files. 

For example, Microsoft’s Paint application can only accept 1 image at a time, so when scanning multiple 
images, Paint would open each time an image is transferred when this option is selected. On the other hand, 
Microsoft’s WordPad will open a multiple page file, so when scanning multiple images WordPad would need 
to launch only one time when this option is not selected. If you scan to WordPad and this option is still 
selected, then WordPad will open 1 time for each image transferred.

• Command line arguments—input the options that are to be used when the application is launched. These 
values are application specific and you should only input values that were provided to you by the 
application developer. Command line arguments are not required for you to use this link, the field can be left 
blank and you can change the other settings in this section as needed.

• Append scan filename(s) to arguments—this option adds the name of every image file to the end of the 
list of arguments specified above. This is the default selection as most applications do not require, and may 
not work with, a job file containing the image names.

• Append job file to arguments—this option adds the name of a job file to the end of the list of arguments 
specified above. This unique file is created at scan time and contains a list of every image in the scan job. 
Only select this option if you are sure that the application you are scanning to can use the job file to accept 
image transfer.

Send to Application OneTouch Link 
Properties window

Send to Application Scan Configuration 
Properties window
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SCANNING TO MULTIPLE DESTINATIONS

Scanning to multiple destinations works the same as when scanning to a single destination, OneTouch simply 
distributes the final scan to several destinations. This option is enabled separately for each OneTouch button. 

1. Open the OneTouch Properties window and click on the Options tab.

2. Select Enable scanning to multiple destinations, then click back on the configuration tab.

3. Click each destination where you want to send the scanned image in the Selected destinations (#) list. Click 
again to deselect a destination.

As you click on each destination, the Selected destinations number will count so you know how many 
applications are selected to receive the image.
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4. If any of the destinations you select have global configuration properties, the Properties button at the 
bottom of the Selected destinations list will be enabled for you to configure the destination options. Click on 
the Properties button to open the OneTouch Link Properties window to configure the destinations.

Each destination that has global properties will be represented by its configuration tab in the OneTouch Link 
Properties window. Please refer to the destination instructions, as described in the previous section(s), for 
configuring destination specific options.

Click on OK when you are done making changes in this window.

5. Select the file format you want for the scanned image in the Select format panel.

You can only scan as one file format at a time, so all selected destinations must have a common file type. As 
you select destinations, destinations that do not have a file type in common with the one you selected, will 
automatically disable. 

For example, if you scan to a printer and to email, only the BMP file format will be available as printers can 
only receive an uncompressed image format. All other image formats and all text formats will be disabled 
until you deselect the printer.
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6. Select the scan configuration you want to use for scanning in the Select configuration list.

Click on the Edit button to open the Scan Configuration Properties window to configure any destination 
specific scanning options. 

Each destination that has per-scan configuration properties will be represented by its configuration tab in 
the OneTouch Scan Configuration Properties window. Please refer to the destination instructions, as 
described in the previous section(s), for configuring destination specific options.

Click on OK when you are done making changes in this window.

7. Click on OK on the OneTouch Properties window.

8. Load the document(s) in the scanner and start scanning with the button you set to scan to multiple 
destinations. 

The scanner starts scanning and when finished, the image is sent to each destination you selected in the 
OneTouch Properties window.

Technical Note

• The Still Image Client destination cannot be used with multiple destination scanning. This destination will 
be disabled when the Enable scanning to multiple destinations is selected.
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SCANNING WITH JOB SEPARATION

Use job separation to have OneTouch create a new file each time a separator is detected when scanning a 
multiple page batch. For example, if you want to scan financial statements from several different banks, you can 
place a stack of statements in the scanner and OneTouch will separate each statement into a different file based 
on your selected job separator.

1. Open the OneTouch Properties window.

2. Select the Destination Application, File Format, and Scan Configuration applicable to your scanning batch.

Make sure the option Create single image files is not selected. If this option is selected, the job separation 
features on the Options tab will be disabled.

3. Click on the Options tab in the OneTouch Properties window.

4. Click on the down arrow next to the Select Button list to select the button you want to modify.

Note that the options in this window are specific to each OneTouch button. 
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5. Click on the option Use job separator when scanning multiple pages.

6. Select one of the two job separation options:

When a blank page is detected—a new file will be created after a blank page is fed through the scanner. 
The blank page is discarded from the scanned image and the new file starts with the next page in the 
document stack. Place a blank page, in the document you are scanning, at each place where you want a new 
file created when scanning is complete.

When you are scanning in Duplex mode, both sides of the page must be blank for this job separation option 
to work.

• Sensitivity—you can adjust the sensitivity level of the blank page detection. For instance, depending 
on the paper weight, color mode, or image processing options selected, you might get varying results. 
Changing the sensitivity level allows you to fine-tune the accuracy of the blank page detection.

When the number of images reaches—input the maximum number of images you want in the scanned 
file. The scanner will create a new file each time that number is reached. 

When you are scanning in Duplex mode, the number of images captured is double the number of pages in 
the scanner. For example, if you are scanning 12 double-sided pages it is counted as 24 images. If you want 
the stack split in half, the number of images reached would be 12.

7. When you are done making changes, click on OK to save the changes and close the window.

8. Place your documents in the scanner and start scanning.

When scanning is finished, each file will be sent to the destination location or application you have selected on 
the button tab.

Technical Note

• When Instant delivery is also selected on the Options tab, each file will be sent as it is created. 
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The options on the Page Settings tab, in the Scan Configuration Properties window will affect the job separation 
options as described below:

Skip blank originals

• The Sensitivity you set for this feature is the one that is used when scanning. The sensitivity level you set in 
the Options tab will be ignored.

• When you are scanning in Simplex mode and the selected job separator is When a blank page is detected, 
the job separation occurs first and a new file will be created each time a blank page is detected. If you want a 
single file created with the blank page discarded, deselect the job separation feature on the Options tab. 

Note that when scanning Duplex, both sides of the page must be blank for the job separation to occur. If 
both sides of a scanned page are blank, the job separation occurs first and a new file will be created each 
time a blank page is detected. If you want a single file created with the blank page discarded, deselect the 
job separation feature on the Options tab or remove the blank page from your scanning batch.

• If you select When the number of images reaches, and input a number in the control box, any blank pages 
will be discarded first, and then the number of images scanned will be counted. For example, if you scan 12 
pages and 3 are blank, the total number of images counted for the job separation will be 9 not 12.
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SCANNING WITH OPTICAL CHARACTER RECOGNITION (OCR)

Optical Character Recognition (OCR) converts text and numbers on a scanned page into editable text and 
numbers. You can then work with the text and numbers to edit, spell check, change font or type size, sort, 
calculate, and so forth.

The OneTouch OmniPage Module must be installed on your computer in order to use the OCR options with the 
OneTouch software and your Visioneer scanner. The OneTouch OmniPage Module was automatically installed 
when you installed your driver from the installation disc.

To scan with OCR:

1. Open the OneTouch Properties window.

2. Select a text editing program in the Select Destination list, then select a text file format in the Select 
format panel.

For example, if you want to edit your document in Microsoft’s WordPad, select that application then choose 
a file format such as TEXT or RTF.

3. Click on OK to save the changes and close the OneTouch Properties window.

4. Press or click the OneTouch button you set to scan with OCR.

Your scanned pages appear in the Destination Application with the text ready for editing and other text 
processing.

NOTE: Visioneer recommends that all OCR processing use the original factory settings for OCR 
scanning that came with your scanner. When scanning with other settings, use at least 300 dpi 
for the resolution. If the original documents are of poor quality or have a small type font, 400 
dpi can be used as the maximum resolution.

NOTE: Some of the illustrations in this section may not look exactly as they appear on your 
computer’s screen. The differences are minor and do not affect the steps to use the new 
features. 
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TEXT FORMATS

You select the text format option by clicking on the text icon on the OneTouch Properties window. 

Selecting the text format option also selects OCR processing as an automatic step for scanning. Therefore, when 
you scan a document with the text format selected, the text portions of the document are automatically 
converted to editable text.

As you select Destination Applications that are text applications, the text format icon changes to match the file 
type of the application. In some cases, the Destination Application supports several file types, and you can right-
click on the icon to choose the particular file type for that application.

The specific file format is the file name extension on the text format icon.

To select a file type for the text format:

1. Select the Destination Application.

This is the text format 
icon. This example of 
the text format icon is 
sPDF.

The specific text format; this 
example is for Rich Text 
Format (.rtf).
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2. Right-click on the text format icon. 

3. Choose the file type that you want for the text format.

Your selection of a file type pertains only to the Destination Application currently selected on the OneTouch 
Properties window. Other Destination Applications that have a text option selected as the Page Format are 
not affected.

Example menu for the text format when 
the Destination Application is Microsoft 
Word.

Example menu for the text format when 
the Destination Application is a Storage 
location.

Simple Text—the .txt file format. Text with no formatting; used by the standard 
Microsoft Notepad application.

Rich Text Format—the .rtf file format. Text that retains formatting when converted. 
Available with Microsoft WordPad and Word.

Word Document—the .doc file format used by Microsoft Word.

Comma Delimited—the .csv file format; used for database or spreadsheet data with 
fields, when the document is converted into editable text the fields are maintained.

Excel Spreadsheet—the .xls file format used by Microsoft Excel.

HTML Document—the .htm file format used to create web pages.

Searchable PDF—the .pdf file format used by Adobe Acrobat. This format converts 
scanned text into PDF with an invisible text layer for searching.
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Additional options are available on the menu for the sPDF and nPDF text formats. The three image quality 
settings are: 

• Minimize Size—smallest file size, lowest image quality.

• Normal—medium file size, some loss of image quality.

• Maximize Quality—largest file size, no loss of image quality.

The Use MRC option is a special processing procedure for documents scanned with the PDF format.

• Use MRC—MRC stands for Mixed Raster Content. MRC is an advanced technique for optimizing the image 
quality of scanned documents. Without MRC, the scanned image is produced using a single process to 
capture and display the image on the computer screen, even if the document contains both text and 
graphics. With MRC, the image is produced using separate processes for text, graphics, and other elements 
on the document page. The result is clearer graphics and sharper text characters. Scans with Use MRC 
selected may take slightly longer to complete the processing. Select Use MRC for documents with harder-
to-read text or lower-quality graphics to get the best possible scan output image. The Use MRC option is 
available for sPDF and PDF.

Normal PDF—the.pdf file format used by Adobe Acrobat. This format converts scanned 
text into a PDF with the text ready for editing in a PDF editing program.

NOTE: Documents scanned with nPDF and sPDF automatically include OCR processing. If the 
processing does not recognize a large number of the text characters in the document, change 
the image quality setting and re-scan the document. For example, change from Minimize Size 
to Normal to see if the text recognition improves.
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SELECTING ONETOUCH OMNIPAGE OCR OPTIONS

The software you installed for your scanner includes a set of advanced OCR options integrated with OneTouch.

To select OCR options available from OneTouch:

1. Open the OneTouch Properties window.

2. Select a Destination Application that has one of the text format file types as the page format, such as 
Microsoft Word or WordPad.

3. Right-click on the page format icon to see the menu.

4. Choose OCR Options from the menu.

The OCR Properties window opens with the OCR tab selected.

NOTE: the OCR options apply globally to all the OneTouch Destination Applications that 
perform OCR. For example, if you select the OCR options for Adobe Acrobat, they also apply to 
WordPad.
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THE OCR TAB

The options shown on the OCR tab window are for spellchecking scanned text, replacing missing or 
unrecognized characters, and setting the speed and quality levels of the OCR processing.

1. Choose the options you want from the OCR window.

• Languages in Document—click on the language(s) in list that correspond to the languages in the 
documents to be scanned. You can click on multiple languages. These are the languages that will be 
recognized during the OCR process. For faster and more reliable language recognition, select only the 
languages in the documents. 
The languages are in alphabetical order. Type the first letter of a language’s name to jump to its section 
in the list.

• Use languages and dictionaries to improve accuracy—select this option to automatically check the 
validity of the recognized words. An OCR engine looks at each letter or symbol on the page 
individually, then “guesses” what the letter or symbol is based on the shape. Therefore, the OCR engine 
may have more than one guess for a particular letter or symbol, a “best guess”, a “second-best guess”, 
and so on. This option tells the OCR engine to look through the dictionary to validate its best guess for 
the letters in that word; if its best guess is not in the dictionary, it checks for the second-best guess, and 
so on. 
For example, if the word “house” appears in the original document but the OCR engine is 75% sure that 
the “o” is actually an “a”, the finished document would have the word “hause”. Turning this option on 
tells the OCR engine to look at the other letters in the word, check to see which version of the word is in 
the dictionary, and output the correct word “house” in the final document. 
The OCR engine does not automatically correct misspelled words that were present in the original 
document.
When dictionaries are selected, the terms in those dictionaries are used to check the spelling. If this is 
option is not selected, User Dictionaries and Professional Dictionaries cannot be selected.
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• User Dictionary—a user dictionary is your personal dictionary with words that you want the OCR 
engine to reference for better accuracy when converting the document into editable text. For example, 
if you scan documents with highly technical terms or acronyms not found in typical dictionaries, you 
can add them to your personal dictionary. You can also add names that you expect to be in the 
documents too. This way, as the OCR process recognizes each letter or symbol, there is a higher chance 
that the technical term or name will be correctly spelled in the final document. You can create multiple 
user dictionaries. See the section Creating Your Own Dictionaries on page 112.
Click the menu arrow and select a user dictionary from the list.
If you select [none] as the user dictionary, the text will be validated using the terms in the dictionaries 
for the selected languages, as well as any professional dictionaries if they are selected.
The label [current] is next to the currently-select user dictionary.

• Professional Dictionaries—these are legal and medical dictionaries containing highly specialized 
words and phrases. The options are: Dutch Legal, Dutch Medical, English Financial, English Legal, 
English Medical, French Legal, French Medical, German Legal, and German Medical. Select the 
appropriate dictionary for the OCR engine to use to validate the scanned text.

• Reject Character—this is the character that the OCR process inserts for an unrecognizable text 
character. For example, if the OCR process cannot recognize the J in REJECT, and ~ is the reject 
character, the word would appear as RE~ECT in your document. The ~ is the default reject character.
Type the character you want to use in the Reject Character box. Try to choose a character that will not 
appear in your documents.

• Missing Character—this is the character that the OCR process inserts for a missing text character. A 
missing text character is one that the OCR process recognizes, but cannot represent because that 
character is not available for the selected language. For example, if the document contains the text 
symbol “Ç” but the OCR process cannot represent that character, then every place “Ç” appears, the OCR 
process substitutes the missing character symbol. The caret (^) is the default symbol for the missing 
character.
Type the character you want to use in the Missing Character box. Try to choose a character that will 
not appear in your documents.

• Recognition Quality—drag the slider to the left or right to set the degree of accuracy for the OCR 
process. The higher the accuracy, the longer the OCR process requires to complete. For clean, highly-
legible documents, you can set the recognition quality to a lower level to produce results more quickly. 

2. Click OK or Apply.

These options will now apply to the OCR processing when you select any text format as the page format.

CREATING YOUR OWN DICTIONARIES

You can create multiple dictionaries for your personal use. For example, you might have different dictionaries for 
separate work projects, especially if each project uses different acronyms and terminology.

To create a personal dictionary:

1. Open any word processing program, such as Microsoft Word, WordPad, or Notepad.

2. Create a new document in the word processing program. 

3. Type each word you want in your new dictionary, followed by a carriage return. Make sure to spell the words 
correctly as they will be used for spellchecking.

Here is an example of what the text file might look like:

• Visioneer
• OneTouch
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• OmniPage
• wysiwyg
• jpeg
• bmp
• sPDF
• nPDF
The file does not have to include every word you want in the dictionary. You will be able to edit the list later. 
In fact, the file does not have to contain any text at all, and you could add the words using the editing 
options. However, if the list of words is long, it’s usually faster to type them in the word processing program. 
Note also that the words do not need to be alphabetized.

4. Save the document in the .txt format and give the file the name that you want for the dictionary. For 
example, give it the name USERDIC1.

5. Now open the OCR Options window. 

6. On the OCR Options window, click the button next to the menu arrow.

7. The User Dictionary Files window opens and shows the available dictionaries.

MyDictionary is an example of a user dictionary.

8. Click Add New. 

The Add New User Dictionary window opens. 

9. Click the drop-down arrow for Files of type and choose Text Files (.txt).
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10. Select the file you just created for your user dictionary and click Open.

In the example above, the file is named USERDIC1.

11. The text file now appears on the list of user dictionaries that you can use for spellchecking.

12. Select a dictionary and click Set As Current to set it as the current dictionary for spellchecking. The label 
[current] is added to the name.

If you don’t want to use any user dictionaries for spellchecking, click [none] at the top of the list.

To remove a dictionary from the list, select it and click Remove. This only removes the dictionary from the 
list. It does not affect the original text file you created with the list of words.

EDITING USER DICTIONARIES

Once a dictionary has been added to the list of user dictionaries, its list of words can be edited.

To edit a user dictionary:

1. On the Add New window, select the dictionary to edit and click Edit.

The Edit User Dictionary window opens. It lists the words currently in the dictionary. The following example 
shows the words OmniPage and OneTouch are in the user dictionary named MyDictionary.

2. To add a new word to the list, type it in the box for User Word and click Add. If the word includes any spaces 
before or after it, those spaces are removed and the word is added to the list.

To delete a word from the list, select it and click Delete.

If a word in the list is misspelled, delete it, then re-type the word correctly in the User Word box and click 
Add.
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3. To import a list of words from another text file, click Import.

The Import Contents of User Dictionary window opens. 

4. Select the file that has the words you want to add to your user dictionary.

Importing will add the entire list of words in a file to the user dictionary.

5. Click Import. The file’s words will be added to your user dictionary list.

6. To export a user dictionary so it can be used by another program, select the dictionary on the User 
Dictionary Files list and click Export. 

The Export User Dictionary window opens.

7. Select the dictionary file to export and click Save.

The file is exported as a formatted dictionary with the .ud filename extension so it can be opened by other 
programs.
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THE FORMAT TAB

The options on the Format tab window are for setting the input and output formats for the scanned documents.

1. Click the Format tab and choose the options you want for both the input and output formats.

Input Format Options

• Automatic—choose this option to let the OCR process determine the format of the pages. Typically 
you select this option when the document has different or unknown types of layouts, pages with 
multiple columns and a table, or pages containing more than one table. The OCR process will then 
determine if text is in columns, an item is a graphic or text, and tables are present.

• Single column no table—choose this option if the document contains only one column of text and no 
tables. Business letters are normally in this form. You can also use this option for documents with words 
or numbers in columns if you do not want them placed in a table or decolumnized or treated as 
separate columns.

• Multiple columns, no table—choose this option if some document pages contain text in columns 
and you want it kept in separate columns, similar to the original layout. If table-like data is 
encountered, it is placed in columns, not in a gridded table. 

• Single column with table—choose this option if your document contains only one column of text 
and a table. The table will be placed in a grid in the Destination Application you have selected. You can 
later specify whether to export it in a grid or as tab-separated text columns.

• Spreadsheet—choose this option if the entire document consists of a table that you want to export to 
a spreadsheet program, or have treated as a table. No flowing text or graphics will be detected.

Output Format Options

• Automatic—the document will be formatted as close to its original as possible. The OneTouch 
software will adjust its settings to the most appropriate for the document being scanned in order to 
match your selected output format. The output quality will be maximized and the processing time 
minimized.

• No formatting—the document will be plain text, one column, left-aligned in a single font and font 
size. You can then export the plain text to nearly all file types and target applications.
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• Retain fonts and paragraphs—this output format retains the font and paragraph styling, including 
graphics and tables without columnized text, but does not retain layout formatting. If the document is 
being scanned as an Excel spreadsheet, each detected table or spreadsheet becomes a separate 
worksheet, while other content is placed on the last worksheet.

• Flowing page—this format preserves the original layout of the pages, including columns. This is done 
wherever possible with column and indent settings, but not with text boxes or frames. Text will then 
flow from one column to the other, which does not happen when text boxes are present. 

• True page—this output format uses absolute positioning on the page to keep the original layout of 
the pages, including columns. This is done with text, picture and table boxes and frames. True Page is 
the only choice for documents scanned with the PDF format. It is not available for the TXT, RTF, CSV, or 
XLS formats.

• Spreadsheet—this output format produces results in a tabular form with each page becoming a 
separate worksheet. The worksheets can then be opened in a spreadsheet application. The 
Spreadsheet output option is only available for documents scanned with the XLS format.

2. Click OK or Apply.

These options will now apply to the OCR processing when you select any text format as the page format.
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ONETOUCH WITH VISIONEER ACUITY TECHNOLOGY

The OneTouch software you received with your Visioneer scanner now includes the Visioneer Acuity technology. 
This application has a set of features for improving and enhancing the quality of scanned documents, especially 
documents that would usually produce poorer quality images. Scan configurations with Acuity options work with 
OneTouch scan settings to produce the best quality images.

This section explains how to use the Visioneer Acuity features when choosing new scan settings for your scanner. 

The Acuity options appear on the Scan Configuration Properties window that you use to create a new scan 
configuration for your scanner.

THE ACUITY SETTINGS

You select the Visioneer Acuity settings when creating or editing a scan configuration on the OneTouch 
Properties window. 

Click the Acuity Settings tab to see the new 
options available for your scanner.
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1. Open the OneTouch Properties window.

2. Click the New button to create a new configuration, or select one of your custom configurations you created 
earlier and click the Edit button.

3. Click the Acuity Settings tab to see the new Acuity settings.

4. Choose the Visioneer Acuity options for the scan configuration.

5. Click the drop-down arrow to choose the type of Acuity settings to use for the new scan configuration. The 
options are:

• Do not use Acuity image processing—Scanning will not use the Acuity processing.
• Default settings—Automatically selects the options your scanner can use with any scan mode 

(Black&White, Grayscale, and Color).
6. Select the options for scanning.

• AutoCrop to original—Select this option to let the software automatically determine the size of the 
item being scanned.

• Straighten image—Select this option to have the software automatically determine if a page is 
skewed, then straighten its image. If the page is scanned at too great an angle, the image may not 
straighten correctly. In that case, re-scan the page.
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• Auto detect color—Determines if a document contains color or not and produces the appropriate 
scanned image. Typically, Auto Color Detect is used when you have a stack of pages to scan, some color 
and others not. Instead of you having to change the scan settings from Color to Black&White and back 
again, the scanner can choose the correct settings automatically.

• Skip blank originals—Recognizes when a page is blank and removes its image. For instance, if you are 
scanning a stack of pages that includes a blank page, its image will not be included with the other 
images from the stack.

• Rotate image—Select an option in this list to have the final image rotated when scanning is complete. 
• Perform edge cleanup—Select this option to have the software remove any thin lines that may be 

around the edges in the scanned image. Edge Cleanup only applies if AutoCrop and AutoDeskew are 
selected so the software can determine where the edges are located. Therefore, selecting Edge 
Cleanup will also select AutoCrop and AutoDeskew. This option is only available when scanning in 
Black&White.

• Despeckle—Speckles are small spots on an image that the scanner interpreted as a valid part of the 
document. The Despeckle option identifies these spots and removes them. This option is only available 
when scanning in Black&White.

• Color dropout—Color dropout is the ability of your scanner to automatically remove a color from a 
scanned image. For example, if you are scanning a letter with a red watermark, you can choose to filter 
out the red so the scanned letter just shows the text and not the red watermark. Color dropout applies 
to Black & White or Grayscale scanning modes.

• Bit depth reduction—Click the drop down menu and select an option from the list. The Bit depth 
reduction options are only available when scanning in black and white.
Error diffusion, Bayer, and Halftone patterns are the intentional application of noise (dithering) in the 
image to help alleviate banding when scanning in binary (black and white) mode. For example, if you 
scan a color photo in black and white, the image file will have large blocks of black and white and the 
image barely recognizable. Dithering the image creates a black and white image that is recognizable.
Dynamic threshold attempts to evaluate the scanned page and automatically adjust the brightness 
and contrast levels to produce the best quality image when scanning in black and white. 

7. Click OK or Apply to add the Acuity options to your scan configuration.

The Acuity icon on the top of the 
OneTouch Panel and on the scan 
configuration remind you that the 
scan will use the Acuity settings.

The summary of the scan settings 
also indicates Acuity settings.
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HARDWARE PROPERTIES

1. Right-click on the OneTouch icon and choose Show Hardware from the pop-up menu.

2. The Hardware Properties dialog box opens and shows information about your Visioneer scanner.

3. Click the Properties button. 
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DEVICE SETTINGS

Please refer to Device Settings on page 163

DRIVER SETTINGS

Please refer to Driver Settings on page 165
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ACCESSING THE SCANNER INTERFACE

Every scanning application will access the scanner using a different method. Below is a brief list of common 
applications and how to initiate a scan from within that application, including some of the applications which 
may have been provided with your scanner. Please refer to the application’s user guide for instructions on using 
the application and accessing the scanner.

• Visioneer OneTouch: Open the Visioneer OneTouch properties window and under the configuration list 
select Configure Before Scan. Click on OK to save the changes and close Visioneer OneTouch. The next 
time you scan using that button, the scanner interface will open for you to set the scan options and start 
scanning.

• Nuance PaperPort: On the toolbar click on the scanner icon to open the scan pane on the left side of the 
PaperPort desktop. Click on the Select... button to open the scanner selection window. Select either the 
TWAIN or WIA driver for your scanner model and then click OK. If you get a message that the scanner is not 
in the PaperPort database, follow the instruction on-screen to run the Scanner Setup Wizard.

• Nuance OmniPage: Go to Tools, then select Options.... Click on the Scanner tab, then click on Setup. 
Follow the instructions on-screen to setup OmniPage to work with the scanner. 

CHOOSING TWAIN OR WIA

A note about your scanner and the TWAIN standard:

TWAIN is a widely recognized standard that computers use to receive images from scanners and digital cameras. 
The TWAIN scanning interface can be accessed from any TWAIN scanning application you have installed on the 
computer. The driver interface described herein is the TWAIN driver that has been developed for your scanner. 

The interface described in this section is the one provided with your scanner and you will see it when scanning 
from PaperPort or OmniPage. Other TWAIN compliant scanning applications may also access this interface. 
However, there are some applications that have their own TWAIN interface. If you are scanning from a software 
application, and see the interface shown in this section, you can use these instructions to scan with the TWAIN 
interface. If you do not see this TWAIN interface, please refer to your scanning application’s user guide for 
instructions.

A note about your scanner and Microsoft WIA (Windows Image Acquisition):

The WIA platform has been developed to enable image transfer from devices using standard Windows 
applications, such as Paint or Windows Fax and Scan, without the need to install additional scanning software. 
Microsoft has developed its own interface for using the scanner with the Windows applications, as well as any 
other WIA compatible applications you may have installed. However, when using a WIA 2.0 compatible 
application, the default behavior will display the TWAIN interface as described in this document. You can change 
the driver behavior to show the Windows interface instead of the custom interface described herein. Please refer 
to Driver Settings for the Hardware Properties and Interface Behavior on page 163 for more information. 

Please refer to your Windows documentation for WIA scanning instructions if you do not see the interface 
described below, or if you have any questions regarding Windows scanning applications. 
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SCANNING

Some features described herein may not be available for the current scanner. Please disregard any information 
about features that you do not see in the interface for your scanner.

NOTE: Visioneer Acuity must be installed for the image processing options, described in this document, to be 
available in the interface for your scanner. Only features that are appropriate for your scanner will be enabled 
after Visioneer Acuity is installed. Visioneer Acuity is automatically installed when you install the scanner driver 
from the installation disc. If you downloaded the scanner driver from our website, make sure you also download 
and install Visioneer Acuity.

1. Load the document(s) in the scanner.

2. Adjust the settings in the interface for the item you are scanning.

3. Click on the Scan button.

4. When scanning is complete, click Done to close the interface.

5. The scanned images are now in the scanning application.

LOCKED SCANNING INTERFACE

If you see this locked version of the scanner’s interface you will be able to select a predefined scanning profile 
from the Presets list, and then click the Scan button to start scanning.

You can also click on the Preview button to open the preview dialogue for you to scan a preview image and set 
custom scan regions.
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NOTE: You can lock or unlock the scanner’s interface from the driver configuration options for your scanner. The 
instructions for changing this setting are in the Driver Settings section of this guide. If you are unable to change 
this setting the option may have been set by your system administrator. Please contact your system administrator 
for more information.
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USING THE PREVIEW WINDOW

Clicking the Preview button will display the preview window for the scanner interface. Use the preview option if 
you want to scan and display a sample image that reflects the current settings in the main interface. After the 
preview is displayed, you can then adjust the settings in the main interface until you are happy with how the 
sample image looks. The preview window is also where you can define custom scan regions. Please refer to Scan 
Regions for instructions on creating and scanning custom regions.

To use the preview window:

1. Select the initial scan settings you want to use for the preview image and scanning.

If you want to modify the settings for a particular preset, make sure you select that preset before continuing. 

2. Click the Preview button to open the preview window.

If there is a page in the scanner, the scanner will scan and display a sample image in the preview window. If 
you do not have a page in the scanner when you click Preview, the preview window will open and display an 
empty scan area. You will need to place a page in the scanner and click Get preview to scan and display a 
sample image.

3. The preview window displays the scan area and the current scan region. This scan region reflects the paper 
size currently selected in the main interface. When you pass the mouse cursor over the scan region it will 
highlight for you to move or resize it. If you move, resize, or add scan regions the main interface will display 
User defined for the page size. Please refer to Scan Regions for instructions on creating, resizing and 
deleting regions.

Click the zoom in or zoom out button to zoom in or out on the preview image in 15% steps. Click the up or 
down arrows for the Zoom level box to zoom in or out on the preview image in 5% steps. Click the zoom to 
fit button to fit the entire preview area within the preview window.
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4. Click Show main UI to bring the main scanner interface in front of the preview window for you to adjust the 
scan settings. 

There are some settings in the main interface, such as brightness and contrast, which will immediately 
update the preview image after you adjust the setting. Other settings, such as changing from color scanning 
to black and white scanning, will not automatically update the sample image.

If you select any of the document image adjustment options, such as an option to automatically crop, 
straighten or rotate an image, it will not show in the sample image preview. The preview window displays an 
unaltered view of the item size and position in the scanner. Any document image adjustment options will be 
used while scanning and saving images.

5. After you adjust the scan settings, click Refresh preview to get a new sample image that reflects the most 
current settings in the main interface.

If you are using a single sheet feed scanner, put the item back in the paper feed slot and then click on the 
Refresh preview button.

6. When you are happy with the sample image, you can click Scan in the preview window or in the main 
interface to scan and save the image with the current scan settings.



SCANNING FROM TWAIN AND WIA 129
When you scan, any settings you adjusted are automatically saved to the Last used settings preset. These 
settings are not retained in a preset until you click Save in the main interface to save the settings to the current 
preset, or save them to a new preset using the Save as dialogue. If you select a different preset from the Presets 
list before scanning, the changes you made will be discarded.

SCAN REGIONS

You can use the preview window to create custom scan regions for the scanner to use for scanning. For example, 
if you want to scan only a specific area of the image, you can move and resize a scan region to focus only on the 
area you want to scan. The final image will be only the size of the region you set.

Important: do not change the page size for the scanned image after you create custom regions. When you have 
set a custom region in the preview window, the page size field will display “user defined” indicating you have 
specified one or more custom regions for scanning. Changing the page size after you create a custom region 
discards the custom regions and sets a single scan region to the size you selected in the page size list.

Creating custom scan regions:

1. Select the preset you want to use for scanning.

2. In the main interface click Preview to open the preview window.

If no previous custom scan regions have been created for the preset you selected, the preview window will 
have a single scan region that is the page size for the current preset. This region will be labeled number 1 
and be displayed as an outline in the preview area.

3. Place an item in the scanner and then click Get preview.

4. The scanner scans and displays a sample image.
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5. Move or resize region 1 until the sample image area you want is within the scan region. 

Resize the region by clicking on one edge of the region outline and dragging the mouse. Move the region by 
clicking in the region then dragging the mouse. Please refer to Move, Resize, or Delete Regions for detailed 
instructions.

6. Create additional scan regions as needed by clicking anywhere in the sample image, hold your mouse 
button down, and then drag your mouse to create a scan region. Release the mouse button when the area 
you want is within the rectangle.

If you want to create a region that overlaps another region, hold the Ctrl (control) key on the keyboard while 
you click and drag the mouse to create the region. You can release the Ctrl key after you start creating the 
overlapping region. You only need to hold down the Ctrl key if the starting point of the overlapping region is 
over another region. If you do not hold down the Ctrl key, when you click on the area that has already been 
set as a region you will move the existing region.

7. Click Close when you are done creating scan regions.
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8. In the main scanner interface click Save to save the regions to the current preset, or save them to a new 
preset using the Save as dialogue.

The Summary area in the main interface will indicate when custom regions have been defined in the 
preview window. Click on View or modify custom regions in the summary area to display the preview 
window.

9. Click Scan in the main interface to scan using the custom regions.

10. When scanning is finished, one image is created for each region set in the preview window.

The number of scan regions you can create is limited by the scanner model and installed modules. For instance, 
most scanners have only one region. When you select a paper size in the Page size list, or input the dimensions in 
the custom page size fields, you are setting a scan region.

When Visioneer Acuity is installed, you can create multiple scan regions for each image scanned. The maximum 
number of scan regions you can create when Visioneer Acuity is installed may vary between scanner models. 
When creating scan regions and you reach the maximum number of allowable scan regions, you will not be able 
to continue creating scan regions until you remove a region you have already created.
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MOVE, RESIZE, OR DELETE REGIONS

Moving regions – to move a region, place your mouse cursor over the region you want to move. The region will 
highlight indicating that it is the active region under the mouse cursor. Click on the region and drag the mouse to 
move the region.

Resizing regions – to resize a region, place your mouse cursor over the edge of the region outline. The cursor will 
change to a dual directional arrow. Click on the line and drag the mouse to resize the region. If you click on the 
top or bottom edge, you can only resize the region up or down. If you click on the left or right edge, you can only 
resize the region left or right. Click on a corner edge and then drag the mouse to resize the region in all directions.

Note that you can only resize the scan regions to be within the scanner’s minimum and maximum supported 
paper sizes. Please refer to the scanner specification table, in the maintenance section of the user guide, for the 
supported paper sizes for your scanner.
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Deleting regions – to delete a region, place your mouse cursor over the region you want to delete. The region 
will highlight indicating it is the active region under the mouse cursor. Right-click on the region and select the 
delete option from the menu.

Move, Resize, or Delete a Blocked Region

If there is a region you cannot move or resize because another region is in the way, you can temporarily move that 
region behind the other regions. Right-click on the region that is in the way and select Temporarily send this 
region to the back to move that region behind the one that you want to move or resize. This is a temporary 
change in the region ordering and cannot be undone. That region will automatically move back into its position 
when you click to move or resize a region.

REORDERING REGIONS

If you have created multiple scan regions, you can reorder the region priority from the right-click menu for the 
regions. The priority determines which region gets processed first while scanning. For example, region 1 will be 
processed first and appear in the scanning application as the first image. Right-click on the region and select an 
option from the menu.
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Make this the first region – select this option to set the region number to 1. This option is not available if the 
region you right-clicked on is already at position 1. After selecting this option, all other regions will have their 
number update automatically as appropriate. 

Make this region a lower number – select this option to move the region number up one in the processing 
order. This option is not available if the region you right-clicked on is already at position 1. After selecting this 
option, all other regions will have their number update automatically as appropriate.

Make this region a higher number – select this option to move the region number down one in the processing 
order. This option is not available if the region you right-clicked on is already the last region in the processing 
order. After selecting this option, all other regions will have their number update automatically as appropriate.

Make this the last region – select this option to set the region number to the last number in the processing 
order. This option is not available if the region you right-clicked on is already at the last position in the processing 
order. After selecting this option, all other regions will have their number update automatically as appropriate.

CLEAR ALL REGIONS

Right-click anywhere in the preview window where there are no regions, and then click on Clear all regions to 
remove all of the regions in the preview area. This will leave only the region labeled as number 1. There must 
always be at least one region for scanning. 
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DOCUMENT SOURCE CONFIGURATION

Some options in the interface may be grayed out and cannot be selected. Grayed out options are either not 
appropriate for the current scanner, the software needed to enable the feature is not installed, or the feature is 
dependent on another setting in the scanner's interface. Hover the mouse cursor over a grayed out feature to see 
information about why the feature is unavailable.

Select Basic or Advanced from the list to show the basic or advanced document source configuration options as 
described below.

BASIC OPTIONS

Click the drop down menu to select the color mode you want to use.

• Color scans the document in color, creating a full color copy of an original document or photograph. Color 
scans have the largest file size.

• Gray scans the document using varying shades of gray to reproduce the document. The grayscale scan 
mode is often used when scanning documents or graphics where the original color does not need to be 
retained, but the graphics need to be legible. Grayscale scanning preserves the graphic quality while 
keeping the file size less than that of a full color scan.

• Black and White scans the document in bitonal where everything on the page is either black or white. This 
setting is often used when scanning typed or written documents. When there are not a lot of graphics, or if 
the graphics are not needed, this setting is ideal for archiving documents to a server or on a disc, send 
through email, or posting to a web page, as the file size is smaller than the other scanning modes.

ADVANCED OPTIONS

• Multi-stream—select this option to have the scanner create an image of each item scanned in each color 
mode selected in the source list.
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Click the drop down menu to select the scanning options you want to use.

The available color modes are:

• Automatic determines the color of the document as it is being scanned.

• Color scans the document in color, creating a full color copy of an original document or photograph. Color 
scans have the largest file size.

• Gray scans the document using varying shades of gray to reproduce the document. The grayscale scan 
mode is often used when scanning documents or graphics where the original color does not need to be 
retained, but the graphics need to be legible. Grayscale scanning preserves the graphic quality while 
keeping the file size less than that of a full color scan.

• Black and White scans the document in bitonal where everything on the page is either black or white. This 
setting is often used when scanning typed or written documents. When there are not a lot of graphics, or if 
the graphics are not needed, this setting is ideal for archiving documents to a server or on a disc, send 
through email, or posting to a web page, as the file size is smaller than the other scanning modes.
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SUMMARY

The Summary area displays some of the basic scan options selected in the interface. Clicking on one of the links 
will open the area of the interface where the setting is located.
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PRESETS

A preset contains all features in the scanner interface, including color mode, resolution, paper size, and so on. You 
can create, import, export, and delete presets. After presets have been added to the interface, click the drop down 
menu and select an option from the list.

• If you select the Last used settings preset, then adjust the settings in the scanner interface, when you scan 
those changes will immediately save to the preset.

• Click the Save button if you want to save changes to the Last used settings preset without scanning. 

• Click the Cancel button to close the scanner interface without saving any changes. 

To save a new preset:

1. Adjust the options in the scanner interface as needed. 

2. Click on the right arrow and select Save as... from the list.

3. After clicking on the save option, a dialogue opens for you to type in a name. Type in the name you want 
then click OK. 

To modify an existing preset:

1. Select the preset you want to modify in the preset list.

2. Adjust the options in the scanner interface as needed. 

3. Click Save.

To rename a preset:

1. Select the preset you want to rename in the preset list.

2. Click the right pointing arrow button and select Rename....
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3. Type an new name for the preset in the name field and then click on OK in the dialogue.

To delete a preset:

1. Click the drop menu under Presets and select the preset you want to delete.

2. Click the right pointing arrow button and select Delete.

3. Click Yes when prompted to confirm that you want to delete the currently selected preset.

EXPORTING PRESETS

1. Click on the right pointing arrow and select Export... from the list.
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2. Click on the browse button  next to the Destination folder field to open a file browsing window. 

3. Browse to a location and select the folder where you want the preset file to be saved. Click on Choose.

Make sure to choose a location where you will be able to easily find the file.

4. Select the preset you want to export in the dialogue for exporting a preset. If you want to export multiple 
presets, click on each preset name. You may need to hold down the Ctrl (Control) key on your keyboard, 
while clicking on each preset name, to select multiple presets.
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5. Click on Export.

If you selected multiple presets to be exported, a file will be created for each preset you selected.

NOTE: the software will look for duplicate preset names. If you see a notification indicating that a preset with the 
same name already exists, select one of the options on-screen to continue. 

• Overwrite—select this option to replace the current preset with the one you selected from the list.
• Keep both—select this option to keep both presets. The preset you selected will have a counting number 

added to the end of the preset name; for example, “Custom preset name (2)”. The original preset name will 
remain unchanged.

• Skip—select this option to skip the preset with the duplicate name.

Select the option Do this for all conflicts to have the action you select in this dialogue be used for all conflicts 
found.

IMPORTING A PRESET

If you have previously exported presets, or another user has given you their presets files, select the import option 
to add those presets to your current list. 

Note that if you import presets that were created when using a scanner that does not have the same hardware 
features as your current scanner, the settings for the presets you import will automatically be updated to reflect 
the supported settings for the current scanner. For example, if you are using a flatbed scanner and you import a 
preset that was created using an ADF scanner, all settings that are specific to ADF scanning will be modified.

1. Click on the right pointing arrow next to the presets list and select Import.... 
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2. Browse to the location where the preset file is saved. If you want to import multiple presets, click on each 
preset name. You may need to hold down the Ctrl (Control) key on your keyboard, while clicking on each 
preset name, to select multiple presets.

3. Click on Open. 

4. The preset will now be in the list of presets available in the scanner's interface.

NOTE: the software will look for duplicate preset names. If you see a notification indicating that a preset with the 
same name already exists, select one of the options on-screen to continue.

• Overwrite—select this option to replace the current preset with the one you selected from the list.
• Keep both—select this option to keep both presets. The preset you selected will have a counting number 

added to the end of the preset name; for example, “Custom preset name (2)”. The original preset name will 
remain unchanged.

• Skip—select this option to skip the preset with the duplicate name.

Select the option Do this for all conflicts to have the action you select in this dialogue be used for all conflicts 
found.
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DOCUMENT SETTINGS

• Main panel—this panel contains the most commonly used scan settings. When the Basic source 
configuration mode is selected, this is the only panel available. Change to the Advanced source 
configuration mode to enable the other panels which are also described in this section. 

• Advanced panel—this panel contains advanced document handling options. If you select an option in this 
panel that also appears on the Main panel, when you return to the Main panel that option will be selected.

The Document settings section when the Basic document source 
configuration mode is selected.

The Document settings section when the Advanced document 
source configuration mode is selected.
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DISABLED OPTIONS IN THIS SECTION

Some options in the interface may be grayed out and cannot be selected. Grayed out options are either not 
appropriate for the current scanner, the software needed to enable the feature is not installed, or the feature is 
dependent on another setting in the scanner's interface. Hover the mouse cursor over a grayed out feature to see 
information about why the feature is unavailable.

MAIN PANEL OPTIONS

Some of the options in this panel may have advanced adjustment options on a different panel in this section. 
When the Advanced configuration mode is selected, an icon will appear next to those features which have 
adjustment options on another tab. Click on one of the icons to go to the area of the interface where the 
adjustment options are located.

Click on a link below to go to the appropriate page in this section for instructions on adjusting the option that is 
displayed on the Main tab.

See Advanced Panel Options on page 147

• Automatic cropping options

• Skip blank originals

• Cleanup edges
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RESOLUTION

The resolution determines the amount of detail you can see in the scanned image. Resolution is the clarity of the 
image measured in dots-per-inch (dpi).

Move the slider left or right to change the resolution for the scanned image. The higher the resolution, the clearer 
the image. However, high resolution scans also produce larger file sizes. The available range displayed in the slider 
area are within the minimum and maximum range supported by your scanner. The resolution slider will always 
display the correct range for the current scanner.

Choosing resolution values

Typically, when making copies of black and white documents, 100–150 dpi will create an image of similar quality 
to the original. When making copies of color documents or photographs, 150–200 dpi will create an image of 
similar quality to the original.

Higher resolution settings are generally used for creating an image that can be enlarged without losing image 
quality, but take longer to scan.

Some resolution settings for typically scanned items are:

• Text document letters, forms, or other typed black and white documents – 100 dpi to 150 dpi

• Text document letters or forms with hand printed text – 150 dpi

• Text document (for OCR) forms, letters, memos, or spreadsheets – 300 dpi

• Business cards or other items with small print – 300 dpi

• Color page with graphics or color photographs – 150 dpi

• Color photographs of poor quality for image enhancement – 300 dpi

• Color photographs for printing – 200 dpi

• Color photographs for email – 100 to 150 dpi

• Magazine page with graphics, line art, or color photographs – 200 dpi

DOCUMENT SIZE

Standard document sizes

Click the drop down menu and select a pre-defined document size from the list. The available document sizes are 
within the scanner's range of minimum and maximum item size. 
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Custom document sizes

Select the measurement units you want to use from the Units list.

If the Document size list does not include the document size for your scanning batch, click in one of the fields 
below the document size list. Input the width of the document in the first field, then input the height in the 
second field. 

You can input a maximum of 17 inches in the height field. Please refer to Long Document if your scanner supports 
page lengths greater than 17 inches and you want to scan long pages.

You can input a maximum of 14 inches in the height field. Please refer to Long Document if your scanner supports 
page lengths greater than 14 inches and you want to scan long pages.

You can only specify values within the scanner's minimum and maximum supported item size. Please refer to the 
maintenance section of the scanner user's guide for this information.

LONG DOCUMENT

Select Long document to enable support of paper sizes up to the scanner maximum. After you select this option 
make sure you input the page length for your document in the custom input field, located below the Document 
size selection list. 

Note that some of the options in the scanner interface cannot be used when the page length will be greater than 
1417 inches. When you select this option, incompatible options will either be automatically disabled or the 
setting will simply be discarded while scanning. 

MANUAL FEED

Select this option to enable a delay from when the last page is scanned and when the scanner stops the scan job. 
This allows you to scan one page at a time without having to click Scan for each page you put in the scanner. 

To scan with manual feed mode:

1. Select Manual feed in the scanner’s interface.

2. In the Timeout field, input the amount of time you want the scanner to wait from when the last page is 
scanned and when the scanner stops scanning.

3. Place a document in the scanner.

4. Click Scan.

5. The scanning progress dialogue on-screen will display a countdown indicating how much time you have to 
place the next document in the scanner.
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6. When you are done scanning all pages in your document, you can click on Abort to stop the timer or simply 
let the timer run out.

STRAIGHTEN IMAGE

Select this option to let the scanner automatically determine if a page is skewed, then straighten its image. This 
option is only available if the scanner supports this feature.

ROTATE IMAGE

Select an option in this list to have the final image rotated when scanning is complete.

ADVANCED PANEL OPTIONS

The options in this panel may also appear in the Main panel, but with additional settings for you to fine-tune the 
feature you've selected. Select the Advanced source configuration mode to show this panel.

SKIP BLANK ORIGINALS

Select this option to have the scanner detect if a blank page has been fed through the scanner, and remove it 
from the final file. 

• Blank threshold—you can use the Threshold slider to fine tune the sensitivity of the blank image detection. 
The results will depend on the scan settings and the types of documents being scanned. In general leave the 
threshold level at the default setting if you are scanning good-quality documents printed on standard 20lb 
printer paper. Try lowering the sensitivity level if your documents contain light colored text or drawings so 
those pages are not detected as blank. Raise the sensitivity level if you are scanning double-sided light-
weight paper where images from the opposite side of the page may appear in the image of the blank side. 
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CLEAN UP EDGES

Select this option to remove any thin lines from around the edges of the final scan. This option will fill the margins 
of the image with the detected edge color. When you select this option, the Width input field will automatically 
enable for you to input the size of the area you want to have filled with the background color. You can specify a fill 
size between approximately 0.04 to 0.39 inches (1 mm to 10 mm).

AUTOMATIC IMAGE CROPPING

Depending on the scanner model and installed software, there may be more than one auto cropping option in 
the interface.

• Crop to original—select this option to let the scanner automatically determine the size of the item being 
scanned. This option is only available if the scanner supports this feature. This option may occasionally be 
grayed out as not all scanning applications support this feature.

• Crop to length—this option tells the scanner to crop the final image to the bottom of the page being 
scanned. This option is only available if the scanner supports this feature. This option may occasionally be 
grayed out as not all scanning applications support this feature.

COMPRESSION OPTIONS

There are two types of image compression functions used during scanning. The input compression option is 
compressing the image when transferring it from the scanner to the TWAIN driver on the computer. The output 
compression option is the TWAIN driver compressing the image before it sends the image to the scanning 
application. In the scanning interface the input compression option is Compress transfers and the output option 
is Compression.

Compress transfers

Select this option to have the scanner compress the image in Gray and Color scans. This reduces the file size and 
allows for faster image transfer from the scanner to the computer. Once the compressed image is on the 
computer, scanner’s driver will then uncompress the image, and perform any image processing functions that 
have been selected in the scanning interface. The uncompressed image is then transferred to the scanning 
application. With Compress transfers, a scanning application such as Nuance PDF Converter, will receive the 
uncompressed image and save the image in whatever file format it uses. You can use the Quality slider to adjust 
the level of compression you want to use.

When the Quality option is set to High quality, there is very little visual difference between a compressed scan 
and an uncompressed scan. When the quality option is set to High compression, there may be a greater visual 
difference between compressed and uncompressed scans.

Quality

You can fine tune the compression level by adjusting the quality slider between high compression and high 
quality. When the quality level is set to high compression, the scanner will scan and transfer images faster than 
high quality, but the image quality of the output scan will be lower.
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Subsampling

The subsampling options allow you to select the encoding ratio between color information and luminosity. 
Subsampling works by lowering the resolution of the RGB colors found in an image without affecting 
luminescence of the image. This compresses the image to create smaller file sizes but it can sometimes result in 
loss of image quality. Depending on the type of image being scanned, subsampling encoding may not have a 
noticeable affect in the final image file. You should try test scans using the different levels of subsampling to make 
sure you are happy with the image quality.

• 4:4:4—no subsampling and the ratio between color and luminosity remains unchanged.

• 4:2:2—mid-level ratio between color and luminosity.

• 4:1:1—highest ratio difference between color and luminosity, which results in saving the smallest file size.

Compression

This option is specific compression for file and memory transfers to an application. It is only available if the 
application you are using can accept a compressed image file. For instance, if your scanning application is set to 
receive JPEG compressed images, then the Compression field will display JPEG. Otherwise, the status for 
Compression will always be disabled and display Uncompressed because the scanning application you are using 
is requesting an uncompressed image.

The Compress transfers option described herein compresses the image for faster transfer from the scanner to 
the computer. The driver uncompresses the image and transfers the uncompressed image to the scanning 
application. The Compression option will often be disabled as most applications do not support receiving a 
compressed image file from the scanner driver.

When this option is available, it is an advanced user and application option and should not be adjusted if you are 
not familiar with the technology. However, if you are certain that you are using an application that can receive a 
compressed image, and you want to be able to change the image compression type, you will need to enable user 
adjustable compression in the scanning interface. Please refer to the Driver Settings section for instructions.

Please note that if you adjust this setting, and the application cannot actually accept the option you change, the 
scanning interface and the application may crash. It is highly recommended that you leave the default options 
and let the application set any image compression.

From the Windows Control Panel

1. Click on the Driver settings tab.

2. Select Enable user compression and Remember compression.

Note that if these two options are grayed out and you cannot select them, then these options are not 
available for your scanner.

3. Click on OK.

4. Open the scanner interface.

5. Change to the Advanced source configuration mode.

6. In the Document settings section click on the Advanced tab.

7. If your scanner and application supports compressed file transfers, the Compression option will now be 
available.
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IMAGE ENHANCEMENTS

Click on the Image Enhancements icon to select options applicable to what type of image processing you want 
applied for the items being scanned.

• Main panel—this panel contains the most commonly used scan settings. Some of the options in this panel 
may have adjustment options on the other panels in this section. When the Basic source configuration 
mode is selected, this is the only panel available. Change to the Advanced source configuration mode to 
enable the other panels which are also described in this section.

• Color processing panel—this panel contains advanced options for processing colors in the final scans.

• Advanced panel—this panel contains advanced image enhancement options for improving the clarity of 
the scanned image. 

The Image enhancements section when the Basic document 
source configuration mode is selected.

The Image enhancements section when the Advanced document 
source configuration mode is selected.
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DISABLED OPTIONS IN THIS SECTION

Some options in the interface may be grayed out and cannot be selected. Grayed out options are either not 
appropriate for the current scanner, the software needed to enable the feature is not installed, or the feature is 
dependent on another setting in the scanner's interface. Hover the mouse cursor over a grayed out feature to see 
information about why the feature is unavailable.

MAIN PANEL OPTIONS

Some of the options in this panel may have advanced adjustment options on a different panel in this section. 
When the Advanced configuration mode is selected, an icon will appear next to those features which have 
adjustment options on another tab. Click on one of the icons to go to the area of the interface where the 
adjustment options are located.

Click on a link below to go to the appropriate page in this section for instructions on adjusting the option that is 
displayed on the Main tab.

See Advanced Panel Options on page 159

• Despeckle
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BRIGHTNESS

Brightness is the overall lightness of the image. Move the slider left or right to darken or lighten the image. 
Adjusting the brightness level adjusts the tone of the pixels, without changing the true color of the pixels; such as 
when adjusting hue. 

Choosing brightness values

Adjusting the brightness level is based on how you want the image to appear and there is no standard to adhere 
to. Below are some recommended options for brightness image correction based on the original document 
quality.

• Original documents of good quality - 50%

• Pencil written letters, forms, or drawings - 25% to 40%

• Faded pictures or old documents with faded text - 35% to 45%

• Light colored carbon copy paper, such as yellow or pale pink or pale green, with light text - 45% to 55%

• Newspaper or magazine pages - 55% to 70%

• Book pages - 55% to 80%

• Pictures taken inside or in the shade - 60% to 85%

Brightness works in conjunction with Contrast for image enhancement. When you are adjusting the brightness 
level to improve the scanned image quality, try adjusting the contrast level as well. The contrast level is the range 
between the lightest and darkest parts of the image. For example, if you scanned a document with notes written 
in pencil, you may have to decrease the brightness level to get the handwritten notes to appear in the scanned 
image. However, when decreasing the brightness, white starts to appear gray in the image. In that case, raise the 
contrast level to make the differences between the lightest and darkest part of the image more defined.

Color image brightness examples

The examples below show the original image at the default setting of 50% brightness level, 25% brightness and 
75% brightness. Adjusting the brightness level does not make the image completely black nor completely white.

Technical note:

Most monitors have a brightness setting that is user adjustable. When viewing scanned images on-screen, versus 
printing the image, the brightness setting of the monitor may affect how light or dark the scanned image looks 
when compared to the original. If the scanned image is too different from the original image, or if adjusting the 
scanned brightness level does not modify the image how you want, try adjusting the monitor's brightness level. 
Refer to the monitor's user guide for adjusting the brightness level and see if the manufacturer has any 
recommended settings.

Brightness: 25% Brightness: 50% Brightness: 75%
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Black background scanners:

Some scanners have a black background plate. A black background results in more precise cropping results and 
skew detection. However, when scanning thin paper, such as multipart color forms or ruled writing paper, which 
are less than 18lb paper weight, the background may “bleed” through into the final image and make the image 
darker than it should be. In that case, try adjusting the brightness level between 60% and 80%.

CONTRAST

Contrast refers to the differences between the light and dark portions in the image. Move the slider left or right to 
decrease or increase the contrast levels. Increasing the contrast level emphasizes the difference between the 
lighter and darker portions of the image, decreasing the contrast de-emphasizes that difference.

Choosing contrast values

While Brightness adds the same amount of gray or white to all pixels in the image, Contrast adjusts the pixels 
based on the pixel color level. For instance, increasing the contrast level will add white to light colored pixels and 
gray to dark pixels to make the difference between color levels in the image crisper. Decreasing the contrast level 
will have the opposite affect, where light colored pixels are modified with gray and dark pixels are modified with 
white to make the transition of colors in the image appear smoother.

Adjusting the contrast level is based on how you want the image to appear and there is no standard to adhere to. 
Contrast works in conjunction with brightness for image enhancement, when decreasing the brightness level, the 
overall image becomes darker, in which case you may want to increase the contrast level so that the differences 
between the lighter and darker portions of the image are clearer.

Below are some recommended options for contrast image correction based on the original document quality.

• Original documents of good quality - 50%

• Pencil written letters, forms, or drawings - 55% to 65%

• Faded pictures or old documents with faded text - 60% to 70%

• Light colored carbon copy paper, such as yellow or pale pink or pale green, with light text - 45% to 55%

• Newspaper or magazine pages - 55% to 70%

• Book pages - 60% to 75%

• Pictures taken inside or in the shade - 40% to 60%

Color image contrast examples

The examples below show the original image at the default setting of 50% contrast level, 25% contrast and 75% 
contrast.

Contrast: 25% Contrast: 50% Contrast: 75%
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Technical note:

Most monitors have a contrast setting that is user adjustable. When viewing scanned images on-screen, versus 
printing the image, the contrast setting of the monitor may affect how clear a scanned image looks when 
compared to the original. If the scanned image is too different from the original image, or if adjusting the scanned 
contrast level does not modify the image how you want, try adjusting the monitor's contrast level. Refer to the 
monitor's user guide for adjusting the contrast level and see if the manufacturer has any recommended settings.

Black background scanners:

Some scanners have a black background plate. A black background results in more precise cropping results and 
skew detection. However, when scanning thin paper, such as carbon copy paper or ruled writing paper, which are 
less than 18lb paper weight, the background may “bleed” through into the final image and make the image 
darker than it should be. In that case, try adjusting the brightness level between 40% and 60%, then adjust the 
contrast level between 60% and 80%. 

GAMMA

Gamma is the tone curve and starting point for image enhancement. Move the slider left or right to darken or 
lighten the image. As you raise or lower the Gamma value, the values at which Brightness and Contrast affect 
the image are changed. It is recommended that you keep the default gamma value, or adjust this setting before 
adjusting the other options. 

Choosing gamma values

As the gamma value is adjusted lower, the tone curve begins to straighten and the shadows of the image are 
expanded, darkening the shadows without overall darkening the image with gray as seen with lowering the 
brightness level. This way, the highlights and shadows in the image are maintained by saturating the pixels with 
darker levels of the same color rather than adding gray to all colors.

As the gamma value is adjusted higher, the tone curve bends and the highlights of the image are expanded, 
lightening the highlights without overall lightening the image with white as seen with raising the brightness 
level. This way, the highlights and shadows in the image are maintained by saturating the pixels with lighter levels 
of the same color rather than just adding white.

Adjusting the gamma level is based on how you want the image to appear and there is no standard to adhere to.

Color image gamma examples

The examples below show the original image at the default setting of 1.8 gamma level, then 1.0 gamma and 2.6 
gamma. Adjusting the gamma level does not make the image completely black nor completely white.

Gamma: 1.0 Gamma: 1.8 Gamma: 2.6
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Technical note:

Most monitors have a gamma setting that is user adjustable. When viewing scanned images on-screen, versus 
printing the image, the gamma setting of the monitor may affect how light or dark the scanned image looks 
when compared to the original. If the scanned image is too different from the original image, or if adjusting the 
scanned gamma level does not modify the image how you want, try adjusting the monitor's gamma level. Refer 
to the monitor's user guide for adjusting the gamma level and see if the manufacturer has any recommended 
settings.

INVERT IMAGE

The Invert image option reverses the color of each pixel in the scanned image. 

When scanning in black and white, each pixel is reversed from black to white and white to black. When scanning 
in grayscale each pixel is reversed to the opposite level of gray. When scanning in color each pixel is reversed to 
the opposite color in the color wheel.

For example, you might choose this option if you are scanning pages that have been printed from newspaper 
microfilm. Newspaper microfilm reverses black and white so that when viewed on a monitor, the text is white and 
the paper is black.

The following example shows the original grayscale image and the inverted image.

The following example shows the original color image and the inverted image. 
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MIRROR IMAGE

The Mirror image option flips the image left-to-right.

BIT DEPTH REDUCTION

The Bit depth reduction options are only available when scanning in black and white. Click the drop down menu 
and select an option from the list.

Threshold and Dynamic threshold

Threshold enables you to set what level of light or dark to look for on a page. When scanning in black and white, 
everything on the page is set to either white pixels or black pixels in the final image. If the text on the page is a 
light color, then the text may be gone in the final image as the scanner will change those light colors to white 
pixels. The threshold slider lets you set the level of darkness or lightness of the text on the page. Dynamic 
threshold attempts to evaluate the image and dynamically adjust the threshold level. These options work best 
for documents that contain only text such as business letters, spreadsheets, reports, etc...

• Threshold—move the slider to the left or right to set the level of lightness or darkness for the scanner to 
leverage from. 

For example, if you are scanning a document with gray text, such as hand written pencil notes, move the 
slider to the right. This tells the scanner that the level to look for is light, and gray pixels are converted to 
black pixels instead of white. If the overall tone of the original document is dark, such as a colored 
background that may interfere with detecting black, move the slider left. This tells the scanner that the level 
to look for is dark, only very dark areas such as text are converted to black pixels.

If you are scanning documents that are in good condition, with black text on a white background, the 
default threshold option will properly scan the item. This level only needs to be adjusted if the scanned 
image does not have image clarity similar to the original.

• Sensitivity—move the slider left or right to adjust the sensitivity level for dynamic thresholding. This slider 
is only enabled when Dynamic threshold is selected in the list.
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Error diffusion, Bayer, and Halftone pattern

Error diffusion, Bayer, and Halftone patterns are the intentional application of noise (dithering) in the image to 
help alleviate banding when scanning in binary (black and white) mode. For example, if you scan a color photo in 
black and white, the image file will have large blocks of black and white and the image barely recognizable. 
Dithering the image creates a black and white image that is recognizable. 

Below is an example of a color scan, a black and white scan without dithering, and a black and white scan with 
dithering. When the image is scaled down, it may look like a grayscale scan. When the image is at normal size or 
enlarged you will be able to clearly see the dithering pattern, as shown in the close-up image.

Bayer dither scan - Close up

COLOR PROCESSING PANEL OPTIONS

The options in this panel are for setting how the scanner should process colors in specific color modes.

Color scan Black and White scan Bayer dither scan
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COLOR DROPOUT

Color dropout tells the scanner and software to remove a specific color from the image. You can choose either 
Red, Green, or Blue, or define a custom color, to be dropped out of an image. 

To input a custom color using its RGB value, select Custom in this list and then input the values for R, G, and B in 
their appropriate boxes, where R, G, and B are numbers from 0 to 255. 

Tolerance—use the slider to adjust the precision of the color dropout. 

• More precise—this option removes a range of colors closest to the pure color selected or defined in the 
custom fields. For example, pure red has an R/G/B value of 255/0/0. Selecting Red indicates that the scanner 
should look for a range of RGB reds close to pure red and remove them from the image. 

• More approximate—this option removes a wider range of colors based on the pure color selected in the 
list or defined in the custom fields.

This option is only available when scanning in grayscale or black and white. The example below shows the 
original text with a red watermark and the resulting image with the color removed.

PERFORM COLOR CORRECTION

Apply color correction to the image so the displayed colors approximate the original item colors. Select this 
option to use the scanner’s default Gamma table which has been calibrated to produce the best quality color 
results for your scanner. When this option is not selected, the resulting scans will be dark and the brightness, 
contrast, and gamma options will require a greater amount of adjustment to affect the overall lightness of the 
image.
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ADVANCED PANEL OPTIONS

The options in this panel may also appear in the Main panel, but with additional settings for you to fine-tune the 
feature you've selected. Select the Advanced source configuration mode to show this panel.

DESPECKLE

This option removes speckles from the background. Speckles are small spots on an image that the scanner 
interpreted as a valid part of the document. For example, an irregularity in the paper, a small wrinkle, or holes 
where a staple was removed may show up as speckles in the scanned image. The Despeckle option identifies 
these spots and removes them. This option is only available when scanning in black and white. 

Radius—this is the size of the area that is evaluated for stray dots. 

Number—this is the maximum number of dots within the radius that should be considered a speckle. If this 
number of dots are in the circle, the dots will not be considered a speckle and remain in the image. If there are less 
than this number of dots in the circle, the dots are considered a speckle and removed from the image.

For example, if the radius is 3 and the number is 5, then the document is evaluated in sections of 3x3 pixels and if 
there are more than 5 stray dots within a 3x3 area, they are not considered a speckle.

FILTER

Use the Filter option to increase or decrease the sharpness in the scanned image. Click the drop down menu and 
select an option from the list. 

• Blur—softens the appearance of the image by evaluating a pixel and changing its color to an average of the 
surrounding pixels. Use the Radius field to set the size of the area for each pixel to be evaluated to adjacent 
pixels.

• Sharpen—sharpens the appearance of the image by evaluating a pixel and changing its color to increase 
the contrast to adjacent pixels. Use the Radius field to set the size of the area for each pixel to be evaluated 
to adjacent pixels.
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• Unsharp mask—adjusts the contrast of edge detail by evaluating the image and setting a lighter and 
darker line on either side of the edge. Use the Sensitivity slider to adjust the tolerance of the unsharp mask.

REDUCE MOIRÉ 

Moiré patterns are wavy or rippled lines that may appear in the scanned images of newspapers and magazines, 
and sometimes scanned images of photos, line drawings, and color scans of textured paper. Select the Reduce 
moiré option to have the driver attempt to find and remove moiré patterns from the image. Please note that 
when Moiré reduction is enabled the scanner may scan slower as the image is checked for moiré patterns. This 
option is only available when scanning in Color or Gray.

Radius—you can set the size of the area to be evaluated in the Moiré radius field. Adjusting the radius will 
produce different results for the various types of items that can be scanned. With this feature, you may have to 
test scan a few times, adjusting the Moiré radius as needed, until you obtain the best results for the type of paper 
in your scan job. Note that the higher the number is in the Moiré radius field, the longer it will take the driver to 
evaluate the image.

WHITE LEVEL

With this option you can set what the scanner should interpret as “white” in the final image, even though the 
page being scanned may have a shaded or off-white background. You may want to adjust this option to have the 
image automatically corrected when you are scanning irregular paper, such as thick or thin paper, that may cause 
the white page in the final image to appear shaded with a pale grey. This option is only available when scanning 
in Color or Gray.

For the best automatic results you can simply select the type of paper you are scanning from the list. Alternatively, 
you can input a number in the Custom value field. The value you set in this field can be from 128 to 255. If you set 
the custom value to 128 you are telling the scanner that all pixels that are grey level 128 or higher (lighter) should 
be changed to white in the final image. If you set the custom value to 255, you are telling the scanner that only 
pure white is white and anything lower than 255 should remain unchanged in the final image.

BLACK LEVEL

With this option you can set what the scanner should interpret as “black” in the final image. If you are scanning 
items that have notes written with a pencil, you may want to raise the black level to have the pencil notes appear 
black in the image. You can set a value for black from 0 to 127. If you set this value to 127, you are telling the 
scanner that all pixels that are grey level 127 or lower (darker) should appear as black in the final image. This 
option is only available when scanning in Color or Gray.

Image with moiré patterns
Image with moiré patterns 
removed
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DRIVER CONFIGURATION

Use the Driver configuration section to configure the add-on modules, select interface options, and view the 
scanner hardware properties. When the Advanced configuration mode is selected, a scanner panel option will be 
available for you to change any hardware settings that may be available for your scanner.

DISABLED OPTIONS IN THIS SECTION

Some options in the interface may be grayed out and cannot be selected. Grayed out options are either not 
appropriate for the current scanner, the software needed to enable the feature is not installed, or the feature is 
dependent on another setting in the scanner's interface. Hover the mouse cursor over a grayed out feature to see 
information about why the feature is unavailable.

MODULE CONFIGURATION

When image processing modules are installed they will appear in the list on the Configure tab. Use this tab to 
enable the modules you want to use when scanning. 

There are some features in the scanner interface that are disabled until a module is installed that contains those 
options. When the module is installed, the features will enable in the scanner interface for you to use them. 

Reordering the Modules

Select a module in the list and click the up or down arrow to change the order of the module in the list. Changing 
the order of the modules changes the order in which the image processing options are used. For example, if there 
are two modules installed and both modules include an automatic image rotation option, the first module's 
rotate option is used and the rotate setting in the second module is ignored so that the image is not rotated 
twice.
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SCANNER CONFIGURATION

The scanner configuration tab shows the hardware information for your scanner.

CALIBRATE

The scanner needs to be calibrated as part of your monthly maintenance of the scanner. If you are seeing image 
quality problems and cleaning the scanner does not resolve the problem, you may need to calibrate the scanner. 

1. If calibration does not resolve any image quality issues you are seeing, you may need to clean the scanner.

2. Click on the Calibrate button to start the utility. When prompted, insert the calibration page with the black 
strip face up.

3. The scanner will grab the page and move it slowly through the scanner while the utility completes the 
process.

4. When prompted, remove the page from the scanner.

Warning: do not attempt to calibrate the scanner with any other type of document (i.e. white paper or a copy of 
the calibration page). 
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HARDWARE PROPERTIES AND INTERFACE BEHAVIOR

You can use the scanner’s properties page to keep track of scanner maintenance, change some of the hardware 
options, configure the scanner interface behavior, and adjust application options that may be available for your 
scanner.

To open the scanner hardware properties page:

• Windows 7 and 8—from the Windows Control Panel, open Hardware and Sound and then Devices and 
Printers. 

Right-click on the scanner and then select Scan properties from the list. Click Yes if you are prompted by 
the Windows User Account Control to confirm that you want make changes to the system settings.

• Windows Vista—from the Windows Control Panel, open Hardware and Sound and then Scanners and 
Cameras.

Click on the scanner icon then click on the Properties button. Click Yes if you are prompted by the Windows 
User Account Control to confirm that you want make changes to the system settings.

• Windows XP—from the Windows Control Panel when in category view, open Printers and Other 
Hardware and then Scanners and Cameras.

Right-click on the scanner and then select Properties from the list.

DEVICE SETTINGS

SCANNER DETAILS

• Firmware version—this is the current hardware processor chip version number.
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• Serial number—the scanner’s unique identification number.

• LLD version—the scanner’s base driver version. This is not the One Touch software revision, TWAIN or WIA 
driver versions.

• Driver version—this is the version of the scanner’s TWAIN driver.

CALIBRATE

The scanner needs to be calibrated as part of your monthly maintenance of the scanner. If you are seeing image 
quality problems and cleaning the scanner does not resolve the problem, you may need to calibrate the scanner. 

1. If calibration does not resolve any image quality issues you are seeing, you may need to clean the scanner.

2. Click on the Calibrate button to start the utility. When prompted, insert the calibration page with the black 
strip face up.

3. The scanner will grab the page and move it slowly through the scanner while the utility completes the 
process.

4. When prompted, remove the page from the scanner. 

Warning: do not attempt to calibrate the scanner with any other type of document (i.e. white paper or a copy of 
the calibration page). 
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DRIVER SETTINGS

The options in this panel are for configuring how the scanner interface will behave in some scenarios. Only 
advanced users should modify any of the options in this section. Options that are not available for your scanner 
will be grayed out and disabled.

GENERAL

• Lock settings—this option prevents the user from making changes to the options in the scanner interface. 
When the interface opens, only the scanning Presets will be available for a user to select and use for 
scanning. 

• Default preset—select the preset you want to have be the default displayed options in the scanner 
interface each time it opens.

TWAIN DRIVER

• Auto transfer—scanning and transfer starts when the scanner detects paper.

• Auto close on transfer—the interface closes automatically when scanning is complete.
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• Force UI-less—select this option to prevent this scanner interface from opening when you initiate a scan in 
the scanning application. This option will only work if your scanning application supports UI-less scanning. 
You may also need to select Auto close on transfer complete for this option to work.

• Profile overrides capabilities—some scanning applications have the option to adjust the scan settings 
and scan without opening this scanner interface. The next time this interface opens, the last used settings 
will match the application settings that were used to scan. Select this option to have the settings reset to the 
last ones used when this interface was open.

• Enable user compression—this option is enabled only if the scanner and the software allow manual 
adjustment of the image compression. 

• Remember compression—when a compression option is available for user adjustment, it cannot be saved 
as part of a preset. Select this option to have the compression setting saved.

WIA DRIVER

• Use default WIA UI—select this option to display the Microsoft WIA interface instead of the TWAIN 
interface in WIA 2.0 applications.

• Emulate WIA 1.0—select this option to display the TWAIN interface for WIA 1.0 compatible applications. 
When this option is selected, WIA 2.0 applications will use the Microsoft WIA interface.

APPLICATION SETTINGS

ONETOUCH SETTINGS

AutoLaunch™ is the scanner’s ability to automatically start scanning when it detects a page has been inserted into 
the scanner. 
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To disable automatic scanning, deselect Turn on AutoLaunch™ and then click on OK to save the changes. Once 
this option has been disabled, you can scan by inserting a page in the scanner and then click on the Scan button 
in the scanning interface. 

Please note that when automatic scanning is enable for OneTouch, and the selected scan configuration in the 
OneTouch Properties window is Configure Before Scan, AutoLaunch will open the TWAIN interface when you 
insert a page and scanning will not continue until you click Scan in the TWAIN interface.
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M A I N T E N A N C E

This chapter includes:

• Cleaning Your Scanner on page 170

• Calibrating Your Scanner on page 172

• Troubleshooting on page 176

• Uninstalling Your Scanner on page 179

• Visioneer RoadWarrior 3 Specifications on page 180

• Visioneer RoadWarrior 3 Parts List on page 181

This section contains information about calibrating, cleaning, troubleshooting, uninstalling, scanner 
specifications and spare parts.
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CLEANING YOUR SCANNER

Clean the inside of the scanner to remove dust and paper debris from the scanner glass, pickup and feed rollers. 
Cleaning the inside of the scanner helps to keep your scanner operating at optimum performance. Dust 
accumulation on the rollers will prevent documents from feeding straight through the scanner, dust on the 
scanner glass will appear as lines in the scanned image.

You should clean the inside of the scanner at least once a week or as needed depending on how often the 
scanner is used. If cleaning the scanner does not resolve any image quality issues, please follow the instructions in 
the next section for calibrating the scanner.

You will need the cleaning cloth provided with your scanner.

1. Place your thumbs on either side of the paper feed slot, underneath the top panel of the scanner.

2. Hold the scanner sides firmly and pull the scanner top up to release it from the body of the scanner.

Use both hands to open the scanner, the top is held down with locking arms on both sides of the paper feed 
slot. If you open only one side, you may warp the scanner top.
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3. Using the cleaning cloth, wipe down all surfaces in the scanner. Make sure to clean the glass in the underside 
of the scanner lid and the feed rollers in the body of the scanner.

4. Gently close the scanner lid. Press down on both sides of the top until you hear a click as the arms lock the 
scanner lid in place. 

ADDITIONAL CLEANING METHOD

The standard cleaning method for your scanner is to use the dry cleaning cloth in the scanner. If lines, smudges or 
blurry areas are still in the scanned image you can try cleaning the scanner with Isopropyl rubbing alcohol.

Please use caution when cleaning the scanner and take appropriate care to prevent injury, skin irritation, or 
damage to the scanner.

• Scanner cleaning cloth.

• A bottle of 70% solution Isopropyl rubbing alcohol.

• Protective rubber or latex gloves.

• Protective eye glasses.

Follow the instructions in the previous section to clean the scanner. However, dampen the cleaning cloth with the 
Isopropyl rubbing alcohol before cleaning the inside surfaces of the scanner.
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CALIBRATING YOUR SCANNER

If your scanned images have black or colored vertical lines and cleaning does not resolve the problem, this may 
be a sign that you need to perform a calibration. 

The scanner should be calibrated as part of your monthly maintenance of the scanner. If the scanner is used daily 
you may need to calibrate the scanner more often. 

You will need to have the calibration page ready.

Warning: do not attempt to calibrate the scanner with any other type of document (i.e. white paper or a copy of 
the calibration page). The calibration routine will fail and indicate the failed calibration by flashing a red LED on 
the scanner. A calibration page was included with your scanner, if you do not have one available, you can order a 
replacement from the Parts & Accessories page for your scanner at www.visioneer.com.

To calibrate the scanner:

1. Right-click on the OneTouch icon and choose Show Hardware from the pop-up menu.
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2. The Hardware Properties dialog box opens and shows information about your Visioneer scanner.

3. Click the Properties button. 

4. Click on the Device Settings tab.

5. Click on the Calibrate button to start the calibration utility.
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6. Place the calibration page, with the black bar face up, into the scanner.

7. The scanner pulls in the calibration page and feeds it slowly through the paper path.

8. When calibration is complete the scanner will clear the calibration page out of the scanner. Remove the 
calibration page when the utility prompts you to. Do not forcefully pull the page out of the scanner, the 
scanner will release the page when it has fully exited out of the scanner.

CALIBRATION ERROR

If there is an error during calibration or if the scanner should disconnect during calibration. The error will display 
on-screen. If you see a message that calibration failed, please run the calibration utility again. 

NOTE: if you attempted to calibrate the scanner with any page other than the calibration page provided with your 
scanner, the calibration routine will fail. You will need to power cycle the scanner, through unplug then re-plug of 
the USB cable, and then restart the calibration.
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CALIBRATING FROM THE WINDOWS CONTROL PANEL

If you did not install OneTouch during the initial installation of the scanner driver, please follow these steps to 
open the scanner’s hardware properties. 

• Windows 7—from the Windows Control Panel, open Hardware and Sound and then Devices and Printers. 

Right-click on the scanner and then select Scan properties from the list. Click Yes if you are prompted by 
the Windows User Account Control to confirm that you want make changes to the system settings. 

• Windows Vista—from the Windows Control Panel, open Hardware and Sound and then Scanners and 
Cameras.

Click on the scanner icon then click on the Properties button. Click Yes if you are prompted by the Windows 
User Account Control to confirm that you want make changes to the system settings.

• Windows XP—from the Windows Control Panel when in category view, open Printers and Other 
Hardware and then Scanners and Cameras.

Right-click on the scanner and then select Properties from the list.

After opening the scanner properties, click on the Device Settings tab to show the scanner information.
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TROUBLESHOOTING

Problem: The scanner won’t scan. What’s wrong?

Check for one of these possible problems:

• Is a cable loose or not plugged in securely? Inspect all cable connections. Make sure all the cables are 
plugged in securely.

• Did you restart the computer after installing the software? If you didn’t restart the computer, it may not 
have loaded all of the software files. Try restarting your computer.

• Did you select another TWAIN source for acquiring images? If you use multiple TWAIN devices with your 
computer, you may have selected another source for images. Start the PaperPort software and make sure 
TWAIN: Visioneer RoadWarrior 3 is selected as your scanner. 

• Is the OneTouch icon in the Windows notification area? OneTouch must be installed for the scanner’s 
AutoLaunch function to work. You can also try scanning from a TWAIN scanning application, such as 
PaperPort.

Problem: Why does my scanner not function after performing a system restore on Windows?

The system restore process may have corrupted some of the driver components. It is recommended that you 
reinstall your scanner driver. 

Problem: Why won’t my scanner work after the computer has been sitting idle for several hours?

This may occur after Windows goes into power saving mode to “hibernate” the computer into a low power state. 
When you move your mouse or type on the keyboard it “wakes” the computer back up and restores full power to 
the system. This power fluctuation during the computer’s hibernating period may sometimes cause the scanner 
to lose communication to the computer.

Problem: I got the error message: PaperPort cannot allocate enough memory to perform internal critical 
operations.

Close any other active applications so that additional memory is available. If you click Continue, PaperPort moves 
the file to the PaperPort data directory and renames the file with the prefix “bad.” This allows you to recover the 
file later. To recover the file, import it into PaperPort by using the Import command in the File menu.

Problem: The installation will not complete successfully. If installation finishes, the scanner’s OneTouch options 
do not seem to work properly.

A likely cause is that some driver programs are already installed on your computer for another scanner. They are 
interfering with the installation and OneTouch options, and you need to remove those other drivers and re-install 
your Visioneer RoadWarrior 3 scanner. Please see the documentation that you received with the other scanner for 
the steps to remove its driver programs. After uninstalling the other scanner’s driver programs, uninstall 
OneTouch using the steps on page 179 then install OneTouch following the instructions in the Installation 
chapter.

Problem: My computer keeps giving me out of hard drive space error messages.

The minimum requirement of 350MB free hard drive space is for the installation of the software and basic, low 
resolution, scanning. High resolution scans result in files that can be over 1 gigabyte in size. Free up some space 
on your hard drive for the software to be able to save the scanned images.
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Problem: When using “Create single image files” not all of the pages scanned are sent to the destination I chose. 
Where are they?

There are a limited number of times that an application can open. When “Create single image files” is selected and 
you are scanning to a destination application, each side of the page scanned will open a new instance of that 
application. If you want to have an image open in an application immediately, limit your scan batch to less than 5 
pages.

Alternatively, you can set your destination to be a folder location on your computer or network using “Transfer to 
Storage”. Select any file format and then scan a large batch of papers. At the end of scanning, the driver will 
immediately save all pages scanned to that folder location without opening an application.

Problem: I have selected “Skip Blank Originals” but not all of the blank pages have been removed. Why are there 
still blank pages in the file? 

If you are scanning light weight paper, such as 16lb or 18lb printer paper, the scanner may be picking up faint 
images through the paper and the driver will not drop those pages out of the final file. The “Skip Blank Originals” 
result will vary based on the DPI range and paper weight. Generally 100 dpi or 150 dpi produces the best results.

Problem: I tried to 'Repair' the OneTouch application by using the 'Change' function through the Add/Remove 
Program within the Control Panel and was not able to repair it. How do I repair OneTouch?

1. Before attempting to repair OneTouch, unplug the USB cable connected to the scanner. 

2. Perform the Change/Repair function again. If you are asked for the Install DVD, insert the disc into the DVD-
ROM player and click OK. 

3. When prompted, plug the USB cable back into the scanner. 

4. When the installation process finishes, click OK on the Complete The Installation window, and then click 
Close. 

5. Reboot your computer.

Problem: OneTouch no longer functions after installing Internet Explorer 7 on Windows XP. How do I resolve this 
issue?

This is a known issue where OneTouch stops responding when Internet Explorer 7 is installed after the scanner. To 
resolve the issue:

1. Open the Windows Add/Remove Programs feature from the Control Panel. 

2. Find Windows Internet Explorer 7 and uninstall it using the change/remove options. Follow the wizard 
through a complete removal of the Internet Explorer 7 software. 

3. Find OneTouch and uninstall it using the change/remove options. Follow the wizard through a complete 
removal of the OneTouch program. 

4. Unplug your scanner's USB cable from the computer. 

5. Reboot your computer. 

6. Install Internet Explorer 7. 

7. Install your scanner driver.

Problem: I am getting an error message that OCR fails every time I try to scan using the OCR features from 
OneTouch. What is the problem?

Anti-SpyWare software that is set to always run may interfere with the driver functionality. It is recommended that 
you temporarily disable or suspend the automatic protection feature during scanning. After scanning is complete 
and your file has been saved, turn the auto-protect feature back on. You do not need to close the Anti-SpyWare 
software.
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Problem: The scanned images are of poor quality even after I recalibrated and cleaned the scanner.

Try reinstalling the scanner driver. The driver software may have been corrupted.

STATUS LIGHT TROUBLESHOOTING

The status light indicates the current state of the scanner:

• Steady blue—indicates the scanner is receiving power. When the scanner driver is installed, it also means 
the scanner is ready to scan.

• Blinking blue—indicates that the scanner is busy (e.g. when scanning or calibrating).

• Blinking red—indicates that there is a hardware error.

ERROR CODES

If your scanner experiences a hardware error, the status light will blink red. It will flash in a numerical sequence, 
pause, then repeat the same number of flashes. The number of times the light blinks between pauses indicates 
the error code number. The following table describes the error codes.

Error Code Problem Description Solution

4 Paper jam Open the scanner and remove the jammed document. 
To reduce the number of paper jams, make sure the 
paper return is closed when scanning thick documents 
and plastic cards. Also make sure the paper guide is 
properly adjusted to the width of the item you are 
scanning. If the paper guide is too narrow for the paper 
being scanned, it will cause the paper to warp and get 
stuck in the paper path.

6 Cover open Make sure the scanner is fully closed after performing 
maintenance on the scanner or removing a jammed 
page. If needed, open and close the scanner again. If the 
problem persists, try power cycling the scanner through 
un-plug and re-plug of the USB cable.

8 Calibration error This may occur if the USB cable was unplugged during 
calibration, the calibration was canceled, or the 
calibration page was not used. 

First, power cycle the scanner through un-plug and re-
plug of the USB cable, and then restart the calibration 
routine. Please refer to Calibrating Your Scanner on 
page 172 for instructions. 
Make sure you have the scanner’s calibration page ready 
when you start the calibration utility.
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UNINSTALLING YOUR SCANNER

Use the options in the Windows Control Panel to remove the scanner driver and modules, and any other software 
provided with the scanner.

Please leave the scanner’s USB cable plugged into the computer while uninstalling the scanner driver. Unplug the 
USB cable when directed to do so in the instructions below.

Open the list of installed programs in the Windows Control panel.

• Windows XP: Open Add/Remove Programs

• Windows Vista and later: Open Programs and Features

Uninstalling the scanner driver:

1. In the list of installed programs click on Visioneer RoadWarrior 3 driver.

2. Click the Change/Remove or Uninstall button.

3. Click Yes when asked to confirm that you want to remove the driver.

The driver will now be removed from the computer. When the driver uninstallation is complete the progress 
window will automatically close.

4. Turn off the scanner and unplug the USB cable.

5. Reboot the computer if you are prompted to do so.

Follow these instructions to remove any of the other software you installed with your scanner. Depending on the 
software provided with your scanner, and which applications you installed during the scanner setup, the 
application list may include:

• Visioneer OneTouch

• Visioneer OneTouch OmniPage OCR module

• Nuance PaperPort

• Nuance OmniPage

• Nuance PDF Converter

Uninstalling Visioneer Acuity™:

Visioneer Acuity is automatically installed when you install the scanner driver using the installation disc. You can 
also download the Visioneer Acuity module from the support pages for your scanner at www.visioneer.com. 
Visioneer Acuity is a utility with advanced image processing options to instantly improve the visual clarity of 
anything you scan.

1. In the list of installed programs select Visioneer Acuity Assets.

2. Click Yes when asked to confirm you want to remove the software.

Depending on the method of installation, and your scanner model, there may be multiple entries for Visioneer 
Acuity in the installed programs list. The additional entries in this list are the image processing libraries needed to 
support various scanner models. These additional items will be called “Visioneer Acuity Assets” followed by a 
version number. In the scenario described here, when you want to uninstall Visioneer Acuity make sure you select 
and uninstall Visioneer Acuity. If you uninstall one of the entries labeled as an “asset” you will still need to uninstall 
the main Visioneer Acuity utility.



VISIONEER ROADWARRIOR 3 SCANNER USER’S GUIDE180
VISIONEER ROADWARRIOR 3 SPECIFICATIONS

Scanning resolution 600 dpi
Bit depth 24-bit color, 8-bit grayscale, 1-bit line art/text
Scan method Fast sheetfed
Light source 3-color RGB LED lamp
Image sensor Contact Image Sensor
Minimum item size 1.5 x 1.5 inches (38 x 38 mm)
Maximum item size 8.5 x 32.0 inches (216 x 813 mm)
Item thickness 16 ~ 32 lbs. (60 ~ 120 g/m2)
Plastic card Yes, non-embossed cards only
Interface USB 2.0 
Scanner dimensions
Width 11.4 inches (290 mm)
Depth 2.14 inches (54 mm)
Height 1.47 inches (37 mm)
Weight 13.4 ox (379 grams)
Operating 
temperature

50°~95° F (10°~35° C without condensation)

Relative humidity 15%~85% (@35° C without condensation)
Power consumption ≤ 2.5 Watts (during operation)

≤ 0.5 Watts (on standby)
USB cable 1830 mm, 28AWG, with core, RoHS compliant
Safety and agency 
certifications

UL, C-UL, FCC Class B, CE, CB, WEEE, RoHS, ENERGY STAR

Supported Operating 
Systems

Microsoft Windows 
- 32-bit XP (Service Pack 2 or 3)
- 32-bit or 64-bit Vista (Service Pack 1 or 2)
- 32-bit or 64-bit 7 (Service Pack 1)
- 32-bit or 64-bit 8

Scanner Drivers TWAIN, WIA
Bundled Software Visioneer® OneTouch™

Visioneer® Acuity™
Nuance PaperPort®
Nuance OmniPage®
Nuance PDF Converter
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VISIONEER ROADWARRIOR 3 PARTS LIST

Please use the following part names and numbers when ordering replacements for your Visioneer RoadWarrior 3

Part Name Part Number

USB Cable 35-0247-000

Calibration Page 05-0885-000

Cleaning Cloth 05-0884-000

Carrying Bag 88-0666-000
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I N D E X
A
Actual size, 70
Acuity image processing, 119
Add Application, 87, 93, 95
Advanced device settings, 70
Advanced Settings tab, 49
Apply button, 41
Aspect ratio, 70
Auto detect color, 120
AutoCrop, 148
AutoCrop to original, 119
AutoLaunch, 27, 30, 32, 33, 38

turn off or on, 31
Automatic color detection, 136
Automatic cropping options, 144
AutoRotate image, 70

B
Bayer, 120
bit depth, 180
Bit Depth Reduction, 156
Bit depth reduction, 120
Black and White, 135, 136, 156
Black Level, 160
Black&White mode, 46
Blur, 159
BMP file format, 53, 59
Brightness, 46, 152, 154
Burn to CD, 67

Destination application, 67

C
Calibrate button, 173
Calibration, 172
CD burner, 67
CD-ROM drive, 11
Center image, 70
Collate copies, 70
Color, 135, 136, 145, 152, 153, 154, 157
Color dropout, 120, 158
Color mode, 46, 58, 136
Comma Delimited, 108
components, 13
Compress transfers, 148
Compression, 149
Compression Options, 148
computer specifications, 11
Configure Before Scan, 45
cancel, 59

Contrast, 47, 152, 153
Copy button, 41
Create single image files, 53
csv file format, 108

D
Delete button, 41
Despeckle, 120, 151, 159
Destination Application

text file format, 107
Destination application, 29, 30, 37, 38, 42, 53, 61, 71

Burn to CD, 67
Email application properties, 84
Event Forward (STI), 89
Image application properties, 92
Microsoft Explorer (HTML), 88
OCR, 40, 106
Text application properties, 86
Text file format, 56
Transfer to Storage properties, 68

Device settings, 31, 121, 173
Disabled Options, 144, 151, 161
Dither, 157
DOC file format, 106
Document Management, 42
Document Settings, 143, 161
Document Source Configuration, 135
documentation, 12
Dots per inch (dpi), 46, 58
Dpi, 145
Driver Configuration, 161
Dynamic threshold, 120

E
Edit button, 41
eMail, 42
Error Diffusion, 157
Error diffusion, 120
Event Forward (STI), 42, 89
Example, 152, 153, 154
Excel Spreadsheet, 108

F
Fax and Print, 42
File format, 30, 37, 53, 58
file format, 108
Filter, 159
Fit to page, 70
flowing page, 117
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Format tab, 116

G
Gamma, 49, 154
Grayscale, 135, 136, 153, 154, 156
Grayscale mode, 46

H
Halftone, 120
Halftone Pattern, 157
Hardware properties, 31, 39
HTM file format, 88
htm file format, 108
HTML Document, 108
HTML page, 88
Hue, 49

I
Image Documents Properties, 92
Image Editors, 42
Image Enhancements, 150
Image file formats, 53
Improvements and Settings, 47
Instant Delivery, 43
Internet Options, 84
Invert Image, 48
Invert image, 155

J
JPG

Image quality and file size, 55
JPG file format, 53, 59

K
Key icon, 45, 47

L
Languages in Document, 111
Last used settings, 138
Lock icon, 45, 47
Logical Form Recognition, 24
Long document, 146

M
Maintain aspect ratio, 70
Manual Feed, 146
Manual Feed Mode, 48
Maximize Quality, 55, 56
Microsoft Internet Explorer, 88
Microsoft Outlook, 42
Microsoft Paint, 42, 92
Microsoft Word, 40, 42, 86, 106
Minimize Size, 55, 56
Mirror image, 156
Missing Character, 112
Module Configuration, 161
Moiré Patterns, 47
monitor, 11
MRC, 109
Multi-stream, 135

N
New button, 41
Normal, 55, 56
Normal PDF, 109
nPDF, 109
Nuance OmniPage® Pro, 24
Nuance PaperPort, 24

O
OCR, 107

columns, 116
tables, 116

OCR Dictionary, 112
OCR input format, 116
OCR Options, 110
OCR output format, 116
OCR tab, 111
OmniPage® Pro, 24
One Touch

Button panel, 38, 39
icon, 38, 39, 40
Options tab, 42
Panel features, 38
properties, 40, 58, 61, 67, 71, 89, 106
Scan multiple pages, 59

One Touch Button Panel
names, 37

One Touch Properties window
options, 45

OneTouch
AutoLaunch, 33
icon, 30, 31
properties, 30

Optical Character Recognition (OCR), 42, 56, 106
Options tab, 42

P
Page Settings tab, 47
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Page size, 145
Paper feed, 13, 29, 59
Paper size, 47
PaperIn, 29, 30, 38
PaperPort, 24
PaperPort desktop, 29, 38
PDF

Image quality and file size, 55
PDF applications, 42
PDF Destinations, 94
PDF file format, 42, 53, 59
Perform color correction, 158
Perform edge cleanup, 120, 148
Pixel, 152, 154, 156, 159
Post-It™ notes and Labels, 27
Presets, 138
Properties button, 41

R
Recognition Quality, 112
Redaction tab, 49
Reduce moiré, 160
Reduce Moiré Patterns, 47
Refresh button, 41
Reject Character, 112
Resolution, 46, 58, 145
Rich Text Format, 108
Rotate image, 120, 147
RTF file format, 40, 106
rtf file format, 108

S
Saturation, 49
Scan configuration, 30, 37, 63

Edit or Delete, 45
Lock or unlock, 47
New, 45

Scan multiple pages, 59
Scan Settings Tab, 46
Scan to Folder, 61

Multiple folders, 63
Scanner

Application settings, 32
Device settings, 31, 121, 173
hardware, 13

scanner
components, 13

Scanner button, 13
Scanner driver, 18
Scanning mode, 45, 46, 58
Screen Resolution, 84, 92
Searchable PDF, 108
Select configuration, 40
Properties, 46

Select destination, 42
Select format, 40
Send to Application, 97
Sharpen, 159
Show all destinations, 42
Show Hardware, 121, 172
Show Progress Window, 43
Simple Text, 108, 109
Size, 47
Skip Blank Originals, 48
Skip blank originals, 120, 147
Software, 18, 24
sPDF, 108
Speckles, 159
spreadsheet, 116, 117
Sti event forwarding, 42
Still Image Client, 89
Storage and CD-R/W, 42
Straighten image, 119, 147
Subsampling, 149
Summary, 137
system requirements, 11

T
Text Documents Properties, 86
Text Editors, 42
text file format, 107
Text file formats, 56
Threshold, 156
TIFF file format, 53, 59
Transfer to Storage, 61, 63

file formats, 57
true page, 117
Turn on AutoLaunch, 32
TWAIN interface, 58, 59
TXT file format, 40, 106

U
Unsharp mask, 160
USB cable, 19
USB port, 13, 19
Use languages and dictionaries to improve 

accuracy, 111
Use MRC, 109
user dictionary

edit, 114
new, 112

User Guides, 25
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V
Vertical lines, 172

W
Warranty, 27
White Level, 160
Word Document, 108

X
xls file format, 108
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